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法律资讯

警告提示系统

为了您的人身安全以及避免财产损失，必须注意本手册中的提示。人身安全的提示用一个警告三角表示，仅与财产

损失有关的提示不带警告三角。警告提示根据危险等级由高到低如下表示。

危险

表示如果不采取相应的小心措施，将会导致死亡或者严重的人身伤害。

警告

表示如果不采取相应的小心措施，可能导致死亡或者严重的人身伤害。

小心

表示如果不采取相应的小心措施，可能导致轻微的人身伤害。

注意

表示如果不采取相应的小心措施，可能导致财产损失。

当出现多个危险等级的情况下，每次总是使用最高等级的警告提示。如果在某个警告提示中带有警告可能导致人身

伤害的警告三角，则可能在该警告提示中另外还附带有可能导致财产损失的警告。

合格的专业人员

本文件所属的产品/系统只允许由符合各项工作要求的合格人员进行操作。其操作必须遵照各自附带的文件说明，特

别是其中的安全及警告提示。 由于具备相关培训及经验，合格人员可以察觉本产品/系统的风险，并避免可能的危

险。

按规定使用 Siemens 产品

请注意下列说明：

警告

Siemens 产品只允许用于目录和相关技术文件中规定的使用情况。如果要使用其他公司的产品和组件，必须得到 
Siemens 推荐和允许。正确的运输、储存、组装、装配、安装、调试、操作和维护是产品安全、正常运行的前提。

必须保证允许的环境条件。必须注意相关文件中的提示。

商标

所有带有标记符号 ® 的都是西门子股份有限公司的注册商标。本印刷品中的其他符号可能是一些其他商标。若第三

方出于自身目的使用这些商标，将侵害其所有者的权利。

责任免除

我们已对印刷品中所述内容与硬件和软件的一致性作过检查。然而不排除存在偏差的可能性，因此我们不保证印刷

品中所述内容与硬件和软件完全一致。印刷品中的数据都按规定经过检测，必要的修正值包含在下一版本中。

Siemens AG
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Postfach 48 48
90026 NÜRNBERG
德国
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Ⓟ 04/2015 本公司保留更改的权利

Copyright © Siemens AG 2014 - 2015.
保留所有权利



目录

1 安全提示...............................................................................................................................................7

2 前言......................................................................................................................................................9

3 简介....................................................................................................................................................17

3.1 确定软件更新策略...........................................................................................................17

3.2 常规要求.........................................................................................................................19

3.3 有关使用新功能的软件更新的重要信息..........................................................................20

3.4 有关操作系统的信息.......................................................................................................23

3.5 PCS 7 附加件目录中产品的信息.....................................................................................24

3.6 通过自动化许可证管理器进行许可..................................................................................24

4 升级步骤概述......................................................................................................................................25

4.1 有关软件更新步骤的信息................................................................................................25

4.2 步骤概述.........................................................................................................................25

5 准备软件更新......................................................................................................................................31

5.1 将 CAS 数据库移植到 Process Historian........................................................................31
5.1.1 修改集中归档概述...........................................................................................................31
5.1.2 如何分离集中归档服务器上的已连接归档段...................................................................31
5.1.3 将 CAS 数据库移植到 Process Historian........................................................................32

5.2 必要的准备工作..............................................................................................................34
5.2.1 准备工作概述..................................................................................................................34
5.2.2 通过 OPC A&E 交换数据................................................................................................35
5.2.3 如何备份 PCS 7 项目数据..............................................................................................35
5.2.4 如何备份用户创建的库....................................................................................................37
5.2.5 块中的操作员文本和显示文本.........................................................................................38
5.2.6 如何导出操作员文本和显示文本.....................................................................................39
5.2.7 非获准的网络适配器.......................................................................................................40
5.2.8 如何检查网络适配器.......................................................................................................41
5.2.9 如何准备具有高精度时间戳功能的项目..........................................................................41
5.2.10 备份用户自定义的状态显示画面。..................................................................................43
5.2.11 备份许可证密钥和授权....................................................................................................43

6 修改硬件.............................................................................................................................................45

6.1 更新硬件概述..................................................................................................................45

6.2 规划和准备......................................................................................................................45

使用新功能的软件更新

维修手册, 03/2015, A5E32786300-AB 3



6.3 如何进行硬件替换的准备工作.........................................................................................46

6.4 如何执行更新和替换硬件................................................................................................47

7 ES 和 OS 上的 PCS 7 安装及设置.....................................................................................................49

7.1 ES 和 OS 上的安装和设置概述.......................................................................................49

7.2 准备 PC 站......................................................................................................................49

7.3 如何安装 PCS 7..............................................................................................................50

7.4 如何实现 PC 站之间的加密通信.....................................................................................53

7.5 更新 SIMATIC PCS 7 AS RTX.......................................................................................55

7.6 处于组态模式和 PG 模式的模块.....................................................................................56

7.7 如何组态和下载 PC 站....................................................................................................57

7.8 PC 网络中的传输率和操作模式......................................................................................59

7.9 安装附加 PCS 7 库.........................................................................................................61

7.10 如何安装附加 PCS 7 库..................................................................................................62

7.11 使用高级过程库有哪些要求？.........................................................................................63

7.12 如何安装附加的非标准库................................................................................................63

7.13 如何更新用户特定的 APL 面板 ......................................................................................64

8 ES 上 PCS 7 项目的修改...................................................................................................................67

8.1 更新 PCS 7 项目.............................................................................................................67

8.2 常规修改.........................................................................................................................67
8.2.1 项目常规修改概述...........................................................................................................67
8.2.2 如何更新操作员站的组态................................................................................................67
8.2.3 更改多语言文本的组态....................................................................................................69
8.2.4 如何检查 PH 一致性.......................................................................................................69

8.3 HW Config 中的修改.......................................................................................................70
8.3.1 硬件修改概述..................................................................................................................70
8.3.2 如何组态更换的硬件.......................................................................................................71
8.3.3 如何设置 CPU 属性........................................................................................................72
8.3.4 如何为 SIMATIC PCS 7 BOX RTX 和 SIMATIC PCS 7 AS RTX 更新硬件配置.............72
8.3.5 如何组态 SIMATIC PDM 服务器.....................................................................................73

8.4 NetPro 中的修改和 CFC/SFC 图表的转换......................................................................75
8.4.1 修改 OS 相关设置的概述................................................................................................75
8.4.2 如何在 NetPro 中检查和修改连接数据............................................................................75
8.4.3 如何转换 CFC 图表和 SFC 图表.....................................................................................77

8.5 更新块.............................................................................................................................77
8.5.1 更新块的任务概述...........................................................................................................77

目录

使用新功能的软件更新

4 维修手册, 03/2015, A5E32786300-AB



8.5.2 新主数据库的集成...........................................................................................................78
8.5.3 面板中消息文本的语言....................................................................................................78
8.5.4 编辑面板文本..................................................................................................................79
8.5.5 从其它库复制对象的规则................................................................................................80
8.5.6 编辑操作员文本的规则....................................................................................................80
8.5.7 如何将其它库中的对象复制到主数据库..........................................................................81
8.5.8 如何填充主数据库...........................................................................................................82
8.5.9 显示归档值的趋势控件....................................................................................................84
8.5.10 如何组态在线趋势控件的扩展.........................................................................................84
8.5.11 如何更新主数据库...........................................................................................................86
8.5.12 如何在块导入中包含块类型的事件文本..........................................................................88
8.5.13 如何导入操作员文本.......................................................................................................89
8.5.14 如何修改操作员文本.......................................................................................................89
8.5.15 如何更新项目中的块类型................................................................................................90
8.5.16 如何更新项目中的 SFC 块类型.......................................................................................92
8.5.17 编译 CFC 图表期间的序列..............................................................................................93
8.5.18 编译 CFC 图表................................................................................................................93

8.6 修改 OS 相关设置...........................................................................................................94
8.6.1 修改操作员站概述...........................................................................................................94
8.6.2 同步 OS 基本画面、本地计算机操作和面板...................................................................94
8.6.3 如何同步 OS 基本画面、本地计算机操作和面板............................................................95
8.6.4 更新画面对象..................................................................................................................97
8.6.5 如何更新画面对象...........................................................................................................98

8.7 Process Historian 的相关修改........................................................................................99
8.7.1 Process Historian 的相关修改总览.................................................................................99
8.7.2 如何更新 Process Historian 和 Information Server.........................................................99
8.7.3 如何将 CAS 替换为 PH............................................................................................... . .100

8.8 修改维护站.................................................................................................................. . .102
8.8.1 维护站更新概述.......................................................................................................... . .102
8.8.2 如何更改 OPC 服务器并修改 SNMP 组态.................................................................. . .102
8.8.3 如何更新诊断设置....................................................................................................... . .104
8.8.4 如何更新诊断画面....................................................................................................... . .105

8.9 附加选项..................................................................................................................... . .107
8.9.1 附加选项概述.............................................................................................................. . .107
8.9.2 更新 PCS 7 OS Web 选件.......................................................................................... . .107
8.9.3 更新使用 SIMATIC Logon 服务的 PCS 7 组件........................................................... . .108

8.10 在 SIMATIC 管理器中使用 OS.................................................................................... . .108
8.10.1 编译概述..................................................................................................................... . .108
8.10.2 编译模式相关信息....................................................................................................... . .108
8.10.3 如何指定编译模式....................................................................................................... . .109
8.10.4 如何编译 OS............................................................................................................... . .110
8.10.5 如何对 OS 客户机进行修改........................................................................................ . .112
8.10.6 不同版本 PCS 7 面板的混合操作................................................................................ . .115

目录

使用新功能的软件更新

维修手册, 03/2015, A5E32786300-AB 5



9 使用 APL........................................................................................................................................ . .117

9.1 切换至最新版本的 APL............................................................................................... . .117

9.2 修改概述..................................................................................................................... . .117

9.3 如何创建项目库.......................................................................................................... . .118

9.4 如何将块复制到项目库................................................................................................ . .119

9.5 如何创建引用列表....................................................................................................... . .120

9.6 如何更新 APL 块......................................................................................................... . .121

9.7 如何更新 S7 程序中的块类型和 SFC 类型.................................................................. . .122

9.8 如何创建块 I/O 的新互连............................................................................................ . .122

10 下载目标系统.................................................................................................................................. . .125

11 激活操作员站.................................................................................................................................. . .127

11.1 激活操作员站概述....................................................................................................... . .127

11.2 如何检查 OS 服务器上的设置..................................................................................... . .127

11.3 如何检查 OS 客户机上的设置..................................................................................... . .128

12 更新 SIMATIC BATCH 工作站....................................................................................................... . .131

13 更新 SIMATIC 路径控制工作站...................................................................................................... . .133

13.1 更新 SIMATIC 路径控制............................................................................................. . .133

14 从中央归档服务器 (CAS) 移植归档数据......................................................................................... . .135

14.1 归档移植总览.............................................................................................................. . .135

14.2 如何将归档移植到 Process Historian 中..................................................................... . .135

A 附录................................................................................................................................................ . .137

A.1 “Pcs7Cntx”块的块 I/O 总览....................................................................................... . .137

索引................................................................................................................................................ . .143

目录

使用新功能的软件更新

6 维修手册, 03/2015, A5E32786300-AB



安全提示 1
西门子为其产品及解决方案提供工业安全功能，以支持工厂、解决方案、机器、设备和/或
网络的安全运行。 这些功能是整个工业安全机制的重要组成部分。 有鉴于此，西门子不断

对产品和解决方案进行开发和完善。 西门子强烈建议您定期了解产品更新和升级信息。

此外，要确保西门子产品和解决方案的安全操作，还须采取适当的预防措施（例如：设备

单元保护机制），并将每个组件纳入先进且全面的工业安全保护机制中。 可能使用的所有

第三方产品须一并考虑。 更多有关工业安全的信息，请访问 http://www.siemens.com/
industrialsecurity。

要及时了解有关产品的更新和升级信息，请订阅相关产品的时事通讯。 更多相关信息，请

访问 http://support.automation.siemens.com。

使用新功能的软件更新
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前言 2
本文档的用途

本文档全面概述了将现有 PCS 7 过程控制系统更新到新版 SIMATIC PCS 7 而必须执行的

步骤。 本文档可在更新 PCS 7 项目时提供支持，并可引导您完成最新软件的安装和调试。

本文档的内容面向维护人员、调试人员及掌握了必要系统知识的有经验的 PCS 7 用户。 本
文档提供了执行软件更新的说明。

有关特定产品的操作方法的信息，请参阅相关产品文档。

本文档的适用范围

本文档适用于软件包过程控制系统；SIMATIC PCS 7 V8.1 SP1。

访问 PCS 7 文档的方式

可在以下位置找到 PCS 7 文档：

● Process Control System; SIMATIC PCS 7 DVD 上

● 安装后的计算机上

● Internet 上

完整版本的文档可在“SIMATIC PCS 7 技术文档”网站找到： http://www.siemens.com/
pcs7-documentation (http:\\www.siemens.com/pcs7-documentation)

说明

PCS 7 自述文件 Vx.x（在线）

Internet 上的 PCS 7 自述文件中提供的信息优先于相应 PCS 7 版本的所有文档。 
请仔细阅读该自述文件；其中包含有关 PCS 7 的重要信息和补充信息。

使用新功能的软件更新
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Process Control System; SIMATIC PCS 7 DVD 上的 PCS 7 文档

● PCS 7 自述文件 Vx.x（离线）

Process Control System; SIMATIC PCS 7 DVD 中的 PCS 7 自述文件包含有关 PCS 7 
的重要信息，其优先级高于随 PCS 7 版本所提供的文档。 安装 PCS 7 后，可在 
Windows“开始”(Start) 菜单的以下路径下找到《过程控制系统 PCS 7；PCS 7 自述文

件》(Process Control System PCS 7; PCS 7 Readme)文档： 
“Siemens Automation > SIMATIC > 产品说明 > <语言>”(Siemens Automation > 
SIMATIC > Product Notes > <language>)

● 可在以下位置找到最重要的 PCS 7 系统文档：

– SIMATIC PCS 7 DVD 中的“_Manuals”文件夹

– 工程师站上 SIMATIC Manager 应用程序的在线帮助（CHM 文件）

– 工程师站上 Windows“开始”(Start) 菜单以下路径下的 PDF 文件：

“Siemens Automation > SIMATIC > 文档 > <语言>”(Siemens Automation > SIMATIC 
> Documentation > <language>)

说明

包括以下 PCS 7 系统文档：

● 目录总览《过程控制系统 PCS 7；PCS 7 文档》(Process Control System PCS 7; 
PCS 7 Documentation)

● 组态手册《过程控制系统 PCS 7；工程组态系统》(Process Control System PCS 7; 
Engineering System)

● 功能手册《过程控制系统 PCS 7；PCS 7 PC 组态》(Process Control System PCS 
7; PCS 7 PC Configuration)

● 组态手册《过程控制系统 PCS 7；操作站》(Process Control System PCS 7; Operator 
Station)

● 功能手册《过程控制系统 PCS 7；OS 过程控制》(Process Control System PCS 7; 
OS Process Control)

● 产品文档随相关产品一起安装。

前言
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Internet 上的 PCS 7 文档（最新版本）

最新版本的 PCS 7 文档可在“SIMATIC PCS 7 技术文档”网站的以下位置找到：

● 在“Software manuals for SIMATIC PCS 7 ...”部分中

– 特定 PCS 7 版本的最新系统文档和产品文档的链接。

– 最新的系统文档“PCS 7 文档门户安装程序”的下载链接。

说明

PCS 7 文档门户安装程序

安装程序包含完整的 PCS 7 系统文档（PDF 文件和在线帮助）。

● 无需 PCS 7 即可运行此安装程序。

● 在工程师站上运行此安装程序时（完全安装和覆盖安装 - 选择原始安装文件夹时），
将更新以下文档：

– “SIMATIC Manager”应用程序的在线帮助： （CHM 文件）

– Windows“开始”(Start) 菜单中的 PCS 7 系统文档： “
Siemens Automation > SIMATIC > 文档 > 语言 > PDF 文件”(Siemens Automation 
> SIMATIC > Documentation > Language > PDF files)

● PCS 7 新闻快讯将通知您新版本的系统文档何时可用。

– 我的文档管理器 (http://support.industry.siemens.com/my/ww/zh/documentation/
advanced/)中手册汇集形式的完整 PCS 7 文档的下载链接。

手册汇集包括硬件和软件手册。

● 在“Hardware Manuals for SIMATIC PCS 7 ...”部分中

– 批准用于某个 PCS 7 版本的组件的最新手册的链接。

– 批准用于 PCS 7 的 SIMATIC PCS 7 工业软件的最新手册的链接。

目录、小册子、客户杂志和演示软件

此信息在以下 Internet 地址提供： 信息和下载中心 (http://www.automation.siemens.com/
mcms/infocenter)

前言
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软件更新的文档

可以在 Internet 上找到有关“软件更新”主题的所有文档。

文档 目录

手册《不使用新功能的软件更新》

(Software update without 
utilization of the new functions)

介绍在不使用新功能的情况下 PCS 7 项目的软件更

新步骤。

● 现有项目的原始版本： 
自 V7.1 SP4 起的 PCS 7

● 在不使用新功能的情况下将项目更新到以下版

本： 
PCS 7 V8.1 SP1

手册《使用新功能的软件更新》

(Software update with utilization of 
new functions)

介绍在使用新功能的情况下 PCS 7 项目的软件更新

步骤。

● 现有项目的原始版本： 
自 V7.1 SP4 起的 PCS 7

● 在使用新功能的情况下将项目更新到以下版本： 
PCS 7 V8.1 SP1

软件更新的附加文档

执行软件更新还需要下列文档中的更多信息：

文档 目录

手册《过程控制系统 PCS 7；服务

支持和诊断》(Process Control 
System PCS 7; 
Service Support and Diagnostics)

确保 PCS 7 系统的可用性；包含关于创建备份及如

何执行固件更新的信息。

手册《过程控制系统 PCS 7；PCS 
7 PC 组态》(Process Control 
System PCS 7; PCS 7 PC 
Configuration)

PCS 7 PC - 硬件和安装；

Windows 设置和工具；

软件包和所需的许可证密钥。

组态手册《过程控制系统 PCS 7；
工程组态系统》(Process Control 
System PCS 7; Engineering 
System)

SIMATIC Manager、CFC、SFC、NetPro 中的组态

步骤指南

组态手册《过程控制系统 PCS 7；
操作站》(Process Control System 
PCS 7; Operator Station)

WinCC 中的组态步骤指南

前言
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文档 目录

功能手册《过程控制系统 PCS 7；
容错过程控制系统》(Process 
Control System PCS 7; Fault-
tolerant Process Control Systems)

容错过程控制系统的组态步骤指南

文档

《过程控制系统 PCS 7；已发布的模

块》

(Process Control System PCS 7; 
Released Modules)

SIMATIC PCS 7 的所有已发布的模块与以下信息一

同列出：

● 产品标识

● 部件编号

● 固件版本

● 简要描述

在线帮助 
WinCC 信息系统

描述 WinCC 项目的更新。

手册《过程控制系统 PCS 7；OS 
Web 选件》(Process Control 
System PCS 7; Web Option for 
OS)

描述 PCS 7 中 OS Web 选件的安装和使用

手册《过程控制系统 PCS 7；
OpenPCS 7》(Process Control 
System PCS 7; OpenPCS 7)

描述在 PCS 7 系统中如何使用带层级访问的 OPC 
A&E 服务器。

功能手册《过程控制系统 PCS 7；
容错过程控制系统》(Process 
Control System PCS 7;
Fault-tolerant Process Control 
Systems)

描述 SIMATIC PCS 7 中容错（冗余）组件的使用原

则。

SIMATIC 手册《S7 F/FH 自动化系

统》(S7 F/FH Automation 
Systems)
SIMATIC S7 F 系统的自述文件

描述使用 S7 F 系统时如何对 S7 F/FH 故障安全系

统进行组态和编程。

包含在 PCS 7 中安装和使用 S7 F 系统可选软件包

时必须考虑的重要信息。

新增内容 有关此版本与 PCS 7 先前版本的不同之处的信息

前言

使用新功能的软件更新
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所需基础知识

要理解本文档，需要具备自动化工程领域的常识和 PCS°7 的基础知识。您还需要了解如何

使用安装了 Windows 操作系统的 PC。

以下文档提供了使用 PCS 7 的基本信息：

● 组态手册《过程控制系统 PCS 7；工程组态系统》(Process Control System PCS 7; 
Engineering System)

● 组态手册《过程控制系统 PCS 7；操作站》(Process Control System PCS 7; Operator 
Station)

● 入门指南《过程控制系统 PCS 7；第 1 部分》(Process Control System PCS 7; Part 1)

软件更新到 PCS 7 V7.1 SP4

将所有项目更新到 PCS 7 V7.1 SP4 需要几个步骤。 您将收到必要的说明以及相关的软件

包。 

约定

在本文档中，软件界面元素的名称使用的语言与本文档的语言一致。 如果为操作系统安装

了多语言软件包，则在切换语言后某些名称将会以操作系统的基本语言显示，因此，会与

文档中所用的名称不同。

与以前版本相比所发生的变化

与先前版本的主要区别大致如下：

自 PCS 7 V8.1 起

● 必须更改操作系统（Windows 7 或 Windows Server 2008 R2）

说明

归档服务器

不支持中央归档服务器 (CAS)。 请使用以下 PC 站代替 CAS：
● Process Historian，作为外部归档服务器

● Information Server，作为报告系统

有关组态的信息，请参见文档《过程控制系统 PCS 7；PCS 7 PC 组态》(Process Control 
System PCS 7; PCS 7 PC Configuration)。
有关移植的信息，请参见文档《SIMATIC；Process Historian 2014；Process Historian 管
理》(SIMATIC; Process Historian 2014; Process Historian Administration)。

前言

使用新功能的软件更新
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● 可以通过加密通信连接过程模式下涉及的 PC 站。

● 使用高级过程库时，操作站的过程画面中可以显示不同库版本 AS 块的块图标。

● 使用高级过程库时，以下功能可在 OS 的过程画面中使用：

– 显示 AS 块的块图标，即使所连接的自动化系统中加载了不同的库版本。 
– 指定高级过程库（自 V8.1 起）中块图标的大小。

● 在 RUN 模式下更改 AS 块的接口 

● 选择性编译和下载自动化系统

自 PCS 7 V8.0 SP1 起

● 用户可组态消息类别

● 基于并行冗余协议 (PRP) 的冗余容错终端总线

● Process Historian
– 冗余 Process Historian
– 将中央归档服务器 (CAS) 移植到 Process Historian

更多相关信息，可参见“WinCC Classic 信息系统”。

● 使用 SIMATIC Management Console 更新计算机

相关信息，请参见在线帮助《SIMATIC 过程控制系统 PCS 7；SIMATIC Management 
Console》(SIMATIC Process Control System PCS 7; SIMATIC Management 
Console)。

自 PCS 7 V8.0 起：

● 使用 Advanced Process Library (APL) V8.0 作为组态时的标准库。

PCS 7 V7.1 或更高版本： 

● PCS 7 安装程序会自动安装所需的修补程序和 SQL server。

● 将 OS 客户端用作维护客户端（对于维护服务器而言，这是 OS 客户端的默认组态）

● 有关 Microsoft Windows 设置和安全设置的信息，请参见白皮书《SIMATIC 过程控制系

统 PCS 7；安全信息注意事项》(SIMATIC Process Control System PCS 7; Security 
Information Note)
可以从 Internet 上的 客户支持 (https://www.siemens.com/automation/service)网站下

载，条目 ID 为 
26462131 (http://support.automation.siemens.com/CN/view/zh/26462131)

前言

使用新功能的软件更新
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● 有关病毒扫描程序的信息，请参见白皮书《SIMATIC 过程控制系统 PCS 7；安全信息

注意事项；设置病毒扫描程序》(SIMATIC Process Control System PCS 7; Security 
Information Note; Setting Virus Scanners)。
可以从 Internet 上的客户支持 (https://www.siemens.com/automation/service)网站下

载，条目号为 
26366540 (http://support.automation.siemens.com/CN/view/zh/26366540)。

● SIMATIC PDM 的体系结构已改变。

更多相关信息，请参见“如何组态 SIMATIC PDM 服务器 (页 73)”部分。

前言

使用新功能的软件更新
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简介 3
3.1 确定软件更新策略

决策过程

选择和使用的文档是否正确取决于软件更新的广度、软件的当前状态以及可能存在的限制

条件。  

下面的流程图显示了更新 PCS 7 工厂时使用的文档。

PCS 7 

使用新功能的软件更新
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说明

操作系统

请遵守操作系统要求。 更多相关信息，请参见《过程控制系统 PCS 7；PCS 7 自述文件》

(Process Control System PCS 7; PCS 7 Readme)文档（Internet 版本）。

说明

软件更新需要执行中间步骤

如果无法直接更新到 PCS 7 项目的最新 PCS 7 版本，则需要执行图中所示的中间步骤。 
必须完成相应文档中介绍的步骤。 
在系统无需永久可操作时例外： 
可以跳过中间步骤中操作员监控系统的下载。

参见

常规要求 (页 19)

简介

3.1 确定软件更新策略

使用新功能的软件更新
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3.2 常规要求

更新软件的常规要求

● PC 硬件必须满足 PCS 7 最新版本的硬件要求。

更多相关信息，请参见《过程控制系统 PCS 7；PCS 7 - 自述文件》(Process Control 
System PCS 7; PCS 7 - Readme) 文档（Internet 版本）。 

● 安装 PCS 7 软件的 PC 必须满足下列要求之一：

– 可以通过网络（共享网络文件夹或 DVD 驱动器）访问 PCS 7 软件。

– 拥有“自己的”DVD 驱动器（例如： USB DVD 驱动器）。

说明

必须先完成软件更新，然后再开始对组态进行其它更改。

● 项目最低必须更新到 PCS 7 V7.1 SP3。 在更新后的项目中只能使用下列版本的 AS 
块：

– PCS 7 V7.1 SP3;PCS 7 V7.1 SP4
– PCS 7 V8.0 SPx
– PCS 7 V8.1 SPx

说明

如果在项目中使用其它版本 PCS 7 中的 AS 块，则需要通过软件更新（使用新功能）

更新这些块。

PCS 7 V7.1 SP3/PCS 7 V7.1 SP4 的库的安装程序位于 DVD2 Process Control 
System; SIMATIC PCS 7 的“Additional_Products”文件夹下。

PCS 7 中的亚洲文本

在以下情况中，您的 PCS 7 版本需要 USB 加密狗：

● 想在亚洲操作系统上安装 PCS 7

● 想安装某个亚洲版本的 PCS 7 

● 想在用户界面中显示亚洲文本 

简介

3.2 常规要求

使用新功能的软件更新
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USB 加密狗存储操作和组态您的 PCS 7 版本所需的许可证信息。请联系您的西门子销售

代理获取可用的亚洲语言版本。

说明

消息指示非亚洲语种的项目中缺少 ASIA 版本加密狗

检查操作系统和 PCS 7 的语言。

若是在 PCS 7 项目中组态了亚洲文本的语言列，而您不需要该亚洲文本时，可以从所有 
OS 项目的文本库中删除这些语言列。 然后可以使用该 PCS 7 版本的许可证密钥运行软

件，而无需 USB 加密狗。

检查兼容性

Siemens 提供有自动化和驱动技术的兼容性检查工具。 相关信息，请参见《PCS 7 自述文

件》(PCS 7 Readme)（Internet 版本，见前言）。 

3.3 有关使用新功能的软件更新的重要信息

执行软件更新的要求

● 使用新功能的软件更新要求将 CPU 切换到 STOP 模式。

● 项目必须是用不低于以下版本的 PCS 7 组态：

PCS 7 V7.1 SP3
如果之前已执行不使用新功能的更新，则需要特别注意这一点。

● 确保硬件满足 PCS 7 的要求。相关信息，请参见“规划和准备 (页 45)”部分。 如果系

统组件不适合 PCS 7 的更新版本，则需要替换这些组件。 在某些情况下，必须调整或

重新组态更新项目中替换过的组件。

● 更新 BIOS 或组件的固件时，建议将这些组件与任何已连接的网络完全断开。

● 完成软件更新后再组态新功能。 

● 请注意，对于要使用新功能的软件更新，必须在添加新库块前删除可能存在于您的项目

或 PCS 7 标准库的主数据库中但不会再使用的块（OB_DIAG、OR_M_16 和 
OR_M_32）。

● 手册包含了一些在概述中未列出的部分。 更新软件时，请遵照这些部分提供的信息，并

检查此信息是否与您的 PCS 7 系统相关。

● 如果在 PCS 7 中使用高精度时间戳功能，则应根据 PCS 7 V8.1 对其进行组态。

简介

3.3 有关使用新功能的软件更新的重要信息

使用新功能的软件更新
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● 有关获准运行 PCS 7 的操作系统的相关信息，请参见文档《过程控制系统 PCS 7；PCS 
7 自述文件》(Process Control System PCS 7; PCS 7 Readme)（在线）。 该文件包含

关于操作系统和必需服务包的更多信息。

下列 PC 站需要服务器操作系统：

– 装有 OS、SIMATIC BATCH 及 SIMATIC Route Control 的服务器（冗余和非冗

余），或者

– OS Web 选件的服务器

– 使用多重项目（中央数据存储）进行工程设计的工程师站及多工程师站的服务器

● 如果更改操作系统，则需要在站组态编辑器和 HW Config 中更新通信组件的版本。版

本取决于目标站上安装的 SIMATIC NET 版本。

– 自 Windows 7 或 Windows Server 2008 R2 起，安装 SIMATIC NET 12.x。根据所

使用的网络适配器，在 HW Config 中选择以下版本的通信组件：

- 使用“IE 常规”标准网络适配器时： V8.2
- 使用通信处理器时（例如 CP 16xx）：V8.1.1

– 确保 PC 站的硬件适用于更新后的 PCS 7 版本（如操作系统、网络适配器）。

说明

归档服务器

不支持中央归档服务器 (CAS)。 请使用以下 PC 站代替 CAS：
● Process Historian，作为外部归档服务器

● Information Server，作为报告系统

有关组态的信息，请参见文档《过程控制系统 PCS 7；PCS 7 PC 组态》(Process 
Control System PCS 7; PCS 7 PC Configuration)。
有关移植的信息，请参见文档《SIMATIC；Process Historian；Process Historian 管
理》(SIMATIC; Process Historian; Process Historian Administration)。

● 项目受密码保护时的软件更新要求在 ES 上装有 SIMATIC Logon。

● 对于为 WinCC 变量导出激活了 FDA 访问保护的项目，必须预先在 SIMATIC Manager 
中打开 WinCC 项目。

● 在 AS 中，PCS 7 版本的所有 PCS 7 库的块可以一起运行。

● 更新 V8.0 之前的 PCS 7 版本时，需要额外的升级许可证密钥：

– V7.0 > V8.0
– V8.0 > V8.1

● 从 PCS 7 V8.1 起，在 OS 的过程画面中可以显示来自不同库版本的 AS 块的相同块图

标。如果一个 OS 分配给了多个 AS，则只可以为每个 AS 组态以下高级过程库版本的 
AS 块：

– PCS 7 V7.1 SP3 的 AS 块
– PCS 7 V8.1 的 AS 块

简介

3.3 有关使用新功能的软件更新的重要信息
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● 在 AS 中组态的 SFC 块必须用最新的 SFC 块替换。

● 组态 OS 期间，多位项目用户可同时处理同一个操作站的以下对象：

– 对一个 OS 的各种过程画面进行编辑。

– 对一个 OS 的各种报告进行编辑。

– 对一个 OS 的各种脚本进行编辑。

● 完成移植后才能使用 PCS 7 的新功能。

● 对自固件版本 V8.1 起的 CPU 410‑5H 提供了“在 RUN 模式下更新类型并更改接口”

功能。 如果要更新的项目完全符合自 PCS 7 V8.1 起的版本，则该功能可用于更新 
PCS 7 库。 

说明

请参阅“确定软件更新策略 (页 17)”部分中的决策帮助

包含附加应用程序/产品的项目

说明

在某些情况下，附加应用程序/产品需要执行中间步骤。 请在开始软件更新之前阅读相关的

文档。

设置 CPU 模块的钝化响应

模块的钝化响应取决于所使用的库：

● 从“冗余 IO”V5.0 库开始，将为特定通道定义该设置。

● 使用“冗余 IO”V4.0 库可选择通道特定的设置，这取决于所使用的模块。

● “冗余 IO”V3.0 库只允许选择模块特定的设置。

基于已组态的硬件，使用“冗余 IO”库 V5.0 或更高版本可自动识别某个模块可能的钝化

响应。 在生成用户程序的过程中，钝化响应将自动进行调节，使响应具有最低数量的钝化

模块通道。

更多相关信息，请参见文档《过程控制系统 PCS 7；容错过程控制系统》(Process Control 
System PCS 7; Fault-tolerant Process Control Systems)。

PCS 7 系统中的时间同步

执行软件更新后，所有 OS 组件的时间同步符合 PCS 7 标准（自 PCS 7 V8.0 起： 非 V5 
兼容模式）。

简介

3.3 有关使用新功能的软件更新的重要信息
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软件更新结果

使用新功能执行软件更新后，更新后的 PCS 7 项目的行为将与用 PCS 7 最新版本创建的

项目的行为类似。

3.4 有关操作系统的信息

建议

在 Windows 域中，如果要通过 Intranet 或 Internet 将系统连接到其它 PC 或使用 PCS 7 
OS Web 选件时，也必须始终使用批准用于 PCS 7 的操作系统。 有关获准的操作系统的

相关信息，请参见《过程控制系统 PCS 7；PCS 7 自述文件》(Process Control System 
PCS 7; PCS 7 Readme)文档（Internet 版本）。

PC 站名称及其计算机名称的命名约定

选择简短的描述性计算机名称，这些名称要能够反映 PC 站在整个系统中的作用。 

● 计算机名称应以字母开头。

● 计算机名只能包含字母和数字。

● 计算机名称最多可包含 15 个字符（受操作系统限制）。

说明

使用获准运行 PCS 7 的操作系统时，应检验是否已按照 RFC1123 修改计算机名称的命

名约定。 可是，在 PCS 7 中不允许计算机名称包含破折号字符“-”！

● 组态 OS 或 BATCH Server 以及工程师站时，以下名称必须相同：

– 计算机名称

– PC 站的名称（在 PCS 7 项目中）

说明

以下文档中详细介绍了项目的其它命名约定：

● WinCC 信息系统“使用项目 > 附录 > 无效字符”

● C:\Program Files\SIEMENS\WINCC\Documents\English\Projects.pdf

简介

3.4 有关操作系统的信息
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3.5 PCS 7 附加件目录中产品的信息

重要信息

如果在过程控制系统中使用了 PCS 7 附加产品（软件包或硬件组件），请与 SIMATIC 
PCS 7 代理联系

3.6 通过自动化许可证管理器进行许可

管理许可证密钥

许可证密钥和授权都可使用自动化许可证管理器进行转移。 下文中一律使用术语“许可证

密钥”，即使产品使用的是基于授权的旧许可证方案。

许可级别     

有关许可证和组态限制的总览，请参见以下文档：

● 在 Internet 上通过技术支持 (http://www.siemens.com/automation/service)获取目录 ST 
PCS 7

● 文档《过程控制系统 PCS 7；许可证和组态限制》(Process Control System PCS 7; 
Licenses and Configuration Limits )（请参见 前言 (页 9)： 访问 PCS 7 文档的方式）

更多信息

自动化许可证管理器的在线帮助

简介

3.6 通过自动化许可证管理器进行许可

使用新功能的软件更新
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升级步骤概述 4
4.1 有关软件更新步骤的信息

-下表概述了在使用新功能更新软件时的所有必要步骤。    

使用表时需要遵循的规则

● 使用这些表作为系统地按顺序执行所有更新步骤的准则。

说明

必须严格遵照本文档中指定的组态步骤顺序来执行软件更新。

● 在每个步骤中，必须执行组态工作时都会收到相应的信息。

● 如果不需要某些新 PCS 7 功能，则不必激活它们。 可以稍后再激活这些功能。 不过，

建议您全部升级本文档中所述的这些功能。

通过 OPC A&E 交换数据

如果在 PCS 7 系统中通过 OPC A&E 交换数据，请在更新软件时遵守《过程控制系统 PCS 
7；OpenPCS 7》文档中的说明。

4.2 步骤概述

以下概述更新软件的步骤。 本文档包含对下表中每一个步骤的全面说明。     

说明

必须先完成软件更新，然后再开始对组态进行其它更改。

建议：

开始更新其它 PC 站之前，请先完成工程组态系统和项目的更新。

表中符号概述

X - 在相关站执行此步骤

X1 — 仅对中央归档服务器执行

使用新功能的软件更新
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X2 - 仅对 Process Historian 执行

步骤概述

步骤 操作 ES OS 服务器 OS 客
户端

AS

针对中央归档的修改

1 将 CAS 数据库移植到 Process Historian (页 32) 仅适用于具有中央归档服务器 (CAS) 
的项目

备份 PCS 7 项目

2 备份 PCS 7 项目数据 (页 35) X    

3 备份创建的库 (页 37) X    

4 导出操作员文本和显示文本 (页 39) X    

5 检查网络适配器 (页 41) X X X  

6 准备具有高精度时间戳功能的项目 (页 41) 

（仅限具有高精度时间戳功能的项目）

X    

7 备份许可证密钥和授权 (页 43) X X X  

更新硬件

8 准备更换硬件 (页 46)    X

9 更新及更换硬件 (页 47)    X

在 ES 和 OS 上进行安装和设置

10 准备 PC 站 (页 49) X X X  

11 安装 PCS 7 软件 (页 50) X X X  

12 设置操作模式“组态模式”/“PG 模式” (页 56) X X   

13 组态并下载 PC 站 (页 57) X X X  

14 安装附加 PCS 7 库 (页 62) X    

15 安装附加非标准库 (页 63) X    

项目中的常规修改

16 使用项目移植器更新 OS (页 67) X    

17 检查 PH 一致性 (页 69) X    

HW Config 中的修改

18 组态更换后的硬件 (页 71) X    

19 设置 CPU 属性 (页 72) X    

升级步骤概述

4.2 步骤概述

使用新功能的软件更新
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步骤 操作 ES OS 服务器 OS 客
户端

AS

20 更新硬件配置 (页 72) 

（仅限使用 SIMATIC PCS 7 BOX RTX 或 SIMATIC PCS 7 
AS RTX 的项目）

    

21 组态 PDM 服务器的地址 (页 73) 

（仅限使用 SIMATIC PDM V7.0 的项目）

X    

NetPro 中的修改和 CFC/SFC 图表的转换

22 在 NetPro 中检查并修改连接数据 (页 75) X    

23 转换 CFC 和 SFC 图表 (页 77) X    

更新块的步骤

24 将对象从其它库复制到主数据库 (页 81) X    

25 完成主数据库 (页 82) X    

26 同步块 (页 86) X    

27 包含事件文本 (页 88) X    

28 导入操作员文本 (页 89) X    

29 修改操作员文本 (页 89) X    

30 更新块类型 (页 90) X    

31 更新 SFC 块类型 (页 92) X    

32 编译 CFC 图表 (页 93) X    

OS 相关设置的修改

33 同步 OS 基本画面、本地计算机操作和面板 (页 95) X    

34 更新画面对象 (页 98) X    

Process Historian 的相关修改

35 更新 Process Historian 和 Information Server (页 99) X X   

36 将中央归档服务器替换为 Process Historian (页 100) X X X  

修改维护站

37 更改 OPC 服务器并修改 SNMP 组态 (页 102) X    

38 更新诊断设置 (页 104) X    

39 更新诊断画面 (页 105) X    

附加选项

40 更新 PCS 7 OS Web 选件 (页 107) X X   

在 SIMATIC Manager 中设置 OS

升级步骤概述

4.2 步骤概述

使用新功能的软件更新
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步骤 操作 ES OS 服务器 OS 客
户端

AS

41 指定编译模式 (页 109) X    

42 编译 OS (页 110) X    

43 调整 OS 客户端 (页 112) X    

使用 Advanced Process Library V8.1 时进行的调整

44 创建引用列表  (页 120) X    

45 互连块 I/O (页 122) X    

下载到目标系统

46 下载目标系统 (页 125)
有关下载选项的更多信息，请参见组态手册《过程控制系

统 PCS 7；工程师站》(Process Control System PCS 7; 
Engineering Station)。

X X X X

激活操作站概述

 激活过程模式的顺序（运行时）：

● Process Historian（如果存在于项目中）

● 主服务器（OS 服务器）

● 备用服务器（冗余 OS 服务器）

● OS 客户端

47 检查 OS 服务器的设置 (页 127)  X   

48 检查 OS 客户端的设置 (页 128)   X  

SIMATIC BATCH 软件更新

49 更新 SIMATIC BATCH 工作站 (页 131) 仅限使用 SIMATIC BATCH 的项目

SIMATIC Route Control 软件更新

50 更新 SIMATIC 路径控制 (页 133) 仅限使用 SIMATIC Route Control 的
项目

从中央归档服务器 (CAS) 移植归档数据

51 将归档移植到 Process Historian 中 (页 135) 仅适用于已将中央归档服务器 (CAS) 
替换为 Process Historian 的项目。

参见

更新使用 SIMATIC Logon 服务的 PCS 7 组件 (页 108)

如何分离集中归档服务器上的已连接归档段 (页 31)

升级步骤概述

4.2 步骤概述

使用新功能的软件更新
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如何组态在线趋势控件的扩展 (页 84)

如何创建项目库 (页 118)

如何将块复制到项目库 (页 119)

如何更新 APL 块 (页 121)

如何更新 S7 程序中的块类型和 SFC 类型 (页 122)

升级步骤概述

4.2 步骤概述

使用新功能的软件更新
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升级步骤概述

4.2 步骤概述

使用新功能的软件更新
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准备软件更新 5
5.1 将 CAS 数据库移植到 Process Historian

5.1.1 修改集中归档概述

中央归档服务器 (CAS)

中央归档服务器 (CAS) 不可用于 PCS 7 V8.1 及更高版本。 

将 CAS 替换为 Process Historian。
自 PCS 7 V7.0 (StoragePlus V1.2) 起支持从中央归档服务器移植归档数据。

如果要使归档数据在软件更新后可用，必须执行下列步骤。

相关信息，请参见以下文档和 Process Historian 相关文档：

● 系统手册《SIMATIC；Process Historian 管理》(SIMATIC; Process Historian 
Administration)的“移植”部分 

● 安装手册《SIMATIC；Process Historian 安装说明》(SIMATIC; Process Historian 
Installation Notes)

5.1.2 如何分离集中归档服务器上的已连接归档段

要求 

● 执行软件更新前，对归档服务器（中央归档服务器 (CAS) 或 StoragePlus 服务器）直接

执行这些步骤。   

● 有权访问 CAS 上的 Windows 用户界面。

步骤

1. 在 Windows“开始”(Start) 菜单中，从 SIMATIC > StoragePlus 子菜单中选择“管理控制台”
(Administration Console) 命令。

2. 在详细信息视图中，单击“分离”(Detach)。
将显示所有已换出的链接归档段的目录。

3. 选择要从归档中删除的归档段。

使用新功能的软件更新
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4. 单击“打开”(Open)。
选定归档段将从归档中分离出来。 归档段从归档中分离后，将从 CAS 的硬盘中删除。 消息
窗口将指示归档段是否已删除。

5. 单击“确定”(OK)。

6. 对所有关闭的归档，重复步骤 2 到 5。

5.1.3 将 CAS 数据库移植到 Process Historian

如果之前在 PCS 7 项目中使用中央归档服务器 (CAS)，则此服务器无法从自 V8.1 起的 
PCS 7 工厂归档新的工厂数据。 

建议：

请使用以下 PC 站代替 CAS：

● Process Historian，作为外部归档服务器

● Information Server，作为报告系统

要求

之前的 CAS 数据库是使用不低于 PCS 7 V7.0 (Storage Plus V1.2) 版本的中央归档服务器

创建的。

准备软件更新

5.1 将 CAS 数据库移植到 Process Historian

使用新功能的软件更新

32 维修手册, 03/2015, A5E32786300-AB



基本步骤

下图给出了在 PCS 7 环境中将 CAS (Central Archive Server) 数据库移植到 
Process Historian 的原理图示例。

图例

1. 安装新的 PC 站
PCS 7 的选择： Process Historian
有关详细信息，请参见 Process Historian；安装说明文档。

2. 更新工程师站的软件。
相关信息，请参见“ES 和 OS 上的 PCS 7 安装及设置 (页 49)”部分。

3. 执行 PCS 7 项目的软件更新。
相关信息，请参见“ES 上 PCS 7 项目的修改 (页 67)”部分。

4. 在 PCS 7 项目内：
将 PCS 7 项目中的  CAS 对象替换为 PH 对象。 
相关信息，请参见“如何将 CAS 替换为 PH (页 100)”部分。

5. 停止 OS 服务器/OS 单工作站系统并更新软件。

准备软件更新

5.1 将 CAS 数据库移植到 Process Historian

使用新功能的软件更新
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6. 运行“PH-Ready 组态”

说明

Process Historian Ready 的组态

激活过程模式前，必须在更新后的 OS 服务器/OS 单工作站系统上组态

“CCCAPHService”。

相关信息，请参见文档《Process Historian；安装说明》(Process Historian; Installation 
Notes) 的“安装 Process Historian Ready 组件”部分

7. 重新启动 OS 服务器/OS 单工作站系统
首次启动更新后的 OS 服务器前，Process Historian 必须运行在“激活”状态下。 更多相
关信息，请参见“如何检查 OS 服务器上的设置 (页 127)”部分。

说明

注意初始调试的启动顺序

如有必要，需重新启动 OS 服务器的过程模式，以建立到 Process Historian 的连接。 

8. 启动移植工具
相关信息，请参见“如何将归档移植到 Process Historian 中 (页 135)”部分。
所有 CAS 数据库的移植将在操作进行期间于后台执行。

5.2 必要的准备工作

5.2.1 准备工作概述

步骤概述

说明

为避免数据丢失，在执行更新前必须先执行以下步骤。

始终应在运行软件更新之前备份 PCS 7 项目。     

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

2 备份 PCS 7 项目数据 (页 35) X    

3 备份创建的库 (页 37) X    

4 导出操作员文本和显示文本 (页 39) X    

准备软件更新

5.2 必要的准备工作

使用新功能的软件更新
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步骤 操作 ES OS 服务

器

OS 
客户

端

AS

5 检查网络适配器 (页 41) X X X  

6 准备具有高精度时间戳功能的项目 (页 41)（仅

限具有高精度时间戳功能的项目）。

X    

7 备份许可证密钥和授权 (页 43) X X X  

其它准备工作

说明

更新 SIMATIC BATCH
如果要在项目中使用 SIMATIC BATCH 并希望对其加以更新，则在进行更新的准备工作

时，必须严格遵守“更新 SIMATIC BATCH 工作站 (页 131)”部分的说明。

 

5.2.2 通过 OPC A&E 交换数据

如果在 PCS 7 系统中通过 OPC A&E 交换数据，请在更新软件时遵守《过程控制系统 
PCS 7；OpenPCS 7》文档中的说明。

5.2.3 如何备份 PCS 7 项目数据

说明

安装或更新 PCS 7 之前，必须准备并备份原始项目，然后才执行软件更新。

注意

确保安全系统组态 
如果要在运行期间更新软件，则必须确保：

● 已关闭所有组态。

● 系统中已加载所有更改。

请按以下操作说明连续执行。

准备软件更新

5.2 必要的准备工作

使用新功能的软件更新
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将项目归档

1. 在 SIMATIC Manager 中，选择菜单命令“文件 > 归档”(File > Archive)。
将打开“归档”(Archive) 对话框。

2. 选择“多项目”(Multiprojects)（或“用户项目”(User Projects)）选项卡。

3. 从列表中选择要归档的项目。

4. 单击“确定”(OK) 保存设置。
将打开“归档 - 选择归档”(Archive - Select Archive) 对话框。

5. 设置驱动器以及归档文件的文件夹。
建议：
选择可表示归档发生日期的项目归档文件名称。 示例： “年月日项目名称”；091230 名称

6. 单击“保存”(Save) 应用设置。
将开始归档过程。

说明

已归档的项目会反映软件更新之前项目的状态。

比较时间戳

1. 在 SIMATIC Manager 中打开 PCS 7 项目。

2. 在组件视图中，选择 AS 的图表文件夹。

3. 双击任意图表。
将打开 CFC 编辑器。

4. 选择菜单命令 CPU >“比较”(Compare)。

5. 比较时间戳“上次编译”(Last compilation) 和“加载程序的编译”(Compilation of the loaded 
program)。

如果时间戳…… ... 则

相同 1. 单击“关闭”(Close)。
将关闭该对话框。

不同 1. 选择菜单命令 CPU >“下载”(Download)。
2. 选中“更改”(Changes) 复选框并应用所有其它标准设置。

3. 单击“确定”(OK)。
开始下载更改。

4. 成功下载更改后，选择菜单命令 CPU >“比较”(Compare)。
“上次离线程序更改”(Last offline program change) 和“上

次在线程序更改”(Last online program change) 时间戳必

须匹配。

6. 对每个自动化系统执行步骤 2 到 5。

准备软件更新

5.2 必要的准备工作

使用新功能的软件更新
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回读 AS 参数设置

如果在 AS 中已设置组态中不存在的参数，则可以将这些设置回读到项目中。 

小心

参数将被覆盖 
请注意，组态中的参数会被覆盖。 是否使用此功能取决于相关系统的性质，并且必须由

负责该系统的技术人员确定。

1. 在 SIMATIC Manager 中打开 PCS 7 项目。

2. 在组件视图中，选择 AS 的图表文件夹。

3. 双击任意图表。
将打开 CFC 编辑器。

4. 选择菜单命令“图表”(Chart) >“回读”(Read Back)。

5. 在“回读”(Read Back) 对话框中，选择条目“CPU 上的程序”(Program on the CPU) 和“仅
与操作员控制和监视有关的数据”(Only data relevant for operator control and monitoring)。

6. 单击“确定”(OK)。 
回读过程随即开始。

7. 对于您需要其当前参数的自动化系统，执行步骤 2 到 6。

备份 OS 数据

如果要在新安装的 PC 上更新软件后使用 OS 服务器，建议备份 OS 服务器的 OS 项目。

默认情况下，OS 的组态数据和归档数据存储在 OS 服务器的 OS 项目中。

要备份数据，请在此文件夹中压缩项目路径并将备份保存在适合的介质上。

SIMATIC PDM

SIMATIC PDM 组态数据将自动包含在 SIMATIC 项目的备份中。

5.2.4 如何备份用户创建的库

简介

为要更新的项目备份任何含有用户特定块集合的项目库，以便可以在更新软件后重新取得

这些数据。 对每个要备份的库执行以下步骤。   

准备软件更新

5.2 必要的准备工作

使用新功能的软件更新

维修手册, 03/2015, A5E32786300-AB 37



步骤

1. 启动 SIMATIC 管理器。
无需打开 PCS 7 项目。

2. 在 SIMATIC 管理器中，选择菜单命令“文件”(File) >“归档”(Archive)。 
将打开“归档”(Archiving) 对话框。

3. 打开“库”(Libraries) 选项卡。

4. 选择要备份的库，然后单击“确定”(OK)。
将打开“归档 - 选择归档”(Archiving - Select Archive) 对话框。

5. 指定文件名和存储路径。

6. 单击“保存”(Save) 按钮。

更多信息

● STEP 7 的在线帮助

5.2.5 块中的操作员文本和显示文本

面板中的信息   

面板可直观显示操作站上的过程并向工厂操作员提供信息，例如：

● 测量值

● 操作限制

● 单元

● 块操作员文本

块中操作员文本和显示文本中的更改

如果已修改块中的操作员文本或显示文本，使其与交付状态不对应，但要使用新的 PCS 7 
块，则必须备份这些“旧”操作员文本或显示文本。

具有项目特定修改的诊断画面

在使用低于 PCS 7 V7.0 SP1 的版本创建的项目中，应备份针对特定项目修改过的诊断画

面。 

准备软件更新

5.2 必要的准备工作

使用新功能的软件更新
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导出操作员文本和显示文本

 SIMATIC Manager 支持将与参数、信号和消息有关的信息导出到一个文件中（格式：

*.csv）。

可在标准的 MS 办公应用程序（如 Excel 和 Access）中编辑此文件。 导出时使用的机制

与切换到项目特定语言时所用的机制相同。 

5.2.6 如何导出操作员文本和显示文本

要求     

● 已在项目中安装了所需的语言。

说明

可以在 SIMATIC Manager 中使用菜单命令“选项 > 显示设备的语言”(Options > 
Language for Display Devices) 查看项目中的可用语言。可用语言的数目是在安装 
Windows 时指定的（系统特性）。

步骤

1. 在 SIMATIC Manager 中打开要更新的项目。

2. 在组件视图中选择主数据库文件夹。
如果未提供此文件夹，则选择项目文件夹。

3. 选择“选项 > 管理多语言文本 > 导出”(Options > Manage Multilingual Texts > Export) 菜单
命令。
将打开“导出用户文本”(Export user texts) 对话框。

4. 进行以下设置：

– 在“文本表”(Text tables) 组中，选择导出文件的存储位置和格式（可能的格式包

括： *.xls 和 *.csv）。

– 在“语言”(Language) 区域选择与显示语言相对应的目标语言和源语言。

5. 单击“确定”(OK)。

6. 如果管理的是多语言项目，请重复第 3 步到第 5 步。确保指定不同的目标目录或导出文件
名。

准备软件更新

5.2 必要的准备工作

使用新功能的软件更新
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5.2.7 非获准的网络适配器

不再支持的通信处理器

说明

通常，以下说明从 PCS 7 V7.0 起开始生效：

不再支持以 PROFIBUS 作为工厂总线。仅支持以工业以太网作为工厂总线。 

PCS 7 不再支持以下通信处理器：

● CP 1413 工业以太网

● CP 1613 A1

● CP 5412 A2 PROFIBUS

● CP 5613 PROFIBUS

必须卸载并删除这些通信处理器。

不被检测的通信处理器

在安装操作系统期间无法检测以下通信处理器：

● 不兼容“即插即用”的通信处理器

● 作为通信处理器的 ISA 插卡

在安装操作系统之前，需用获准的通信处理器替换这些 CP。

PC 站中的通信处理器

请注意，还必须从 PCS 7 项目的 PC 站中移除上述硬件。 

说明

移除通信处理器之后，必须重新组态连接。

更多信息

有关适合的 PC 和网络适配器的信息，请参见目录总览《过程控制系统 PCS 7；已发布模

块》(Process Control System PCS 7; Released Modules)。

准备软件更新

5.2 必要的准备工作

使用新功能的软件更新
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5.2.8 如何检查网络适配器

简介

在 PC 上安装操作系统后，应检查操作系统是否识别您正在使用的网络适配器（通信处理

器或网卡）。

步骤

1. 单击桌面上的“工作区”图标。

2. 在快捷菜单中，选择菜单命令“属性”(Properties)。

3. 打开“硬件”标签。

4. 单击“设备管理器”(Device Manager) 按钮。
将打开“设备管理器”(Device Manager) 对话框。
可在“设备管理器”中找到检测出的模块：

– 检测到的通信处理器 (CP) 列于“SIMATIC NET”文件夹中。

– 在“网络适配器”(Network Adapters) 文件夹中可找到检测出的网络适配器。

5. 关闭对话框。

更多信息

● 文档： 《PCS 7；已发布模块》

5.2.9 如何准备具有高精度时间戳功能的项目

这些步骤仅限使用了 PCS 7 功能“高精度时间戳”的项目。

说明

高级过程库 (APL, Advanced Process Library) 的块

如果第一次使用 APL 的函数，则需要按照《过程控制系统 PCS 7；高精度时间戳》(Process 
Control System PCS 7; High-precision time stamping) 文档所述重新组态项目。 

要求

● 已编译并传送当前版本的所有 SIMATIC 站。

准备软件更新

5.2 必要的准备工作

使用新功能的软件更新
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步骤

对具有时间戳功能的每个 CPU 执行下列步骤：

1. 从树形视图中选择下列路径：“项目 > SIMATIC 站 > CPU > S7 项目 > 图表”(Project > 
SIMATIC Station > CPU > S7 Project > Charts)。

2. 选择命令菜单“选项 > 图表 > 图表引用数据”(Options > Charts > Chart Reference Data)。
“图表引用： 图表引用数据..”(Chart ref.:Chart reference data..) 对话框将打开。

3. 选择菜单命令“视图”(View) >“块类型”(Block types)。

4. 单击表格中的标题“块类型”(Block types)。
将以分类顺序显示该 CPU 的块。

5. 在“图表引用：图表引用数据..”(Chart ref.: Chart reference data..) 对话窗口中搜索
“IM_DRV”。

6. 双击“IM_DRV”条目。
将打开相关 CFC 图表。

7. 在 CFC 编辑器中，选择“图表 > 新建...”(Chart > New...) 菜单命令
。将打开“打开”(Open) 对话窗口。

8. 转到“对象名称”(Object name) 输入行，并为临时 CFC 图表（如 TEMP_IM_DRV_1）键入
名称（如 TEMP_IM_DRV_"Number"）。

9. 在 CFC 编辑器中，选择“窗口”(Window) >“排列方式”(Arrange) >“垂直平铺”(Tile 
vertically) 菜单命令。

10.将 IM_DRV 块从系统图表拖放到临时 CFC 图表（如 TEMP_IM_DRV_1）中。

11.保存 CFC 图表。

12.对 CPU 中的所有 IM_DRV 块重复步骤 5 到 11。

说明

将 IM_DRV 块全部成功地移动到临时 CFC 图表后，系统图表中将不再含有任何 IM_DRV 
块。 系统图表的名称以“@”字符开头。

路径名称在“图表引用：图表引用数据...”(Chart ref.: Chart reference data...) 对话框窗

口的“图表”(Chart) 列中提供。

13.对项目中的所有 SIMATIC 站重复步骤 1 到 12。

生成 AS 程序

说明

移动 IM_DRV 块后，请勿生成该自动化系统的 AS 程序。 
在软件更新过程中，会将这些块自动移动到系统图表中，并删除消息文本。

仅当系统图表中不存在 IM_DRV 块时，才能再次生成 AS 程序。

准备软件更新

5.2 必要的准备工作
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在新工程师站上更新 PCS 7

要恢复对“高精度时间戳”功能所做的修改，应再次归档 PCS 7 项目（“如何备份 PCS 
7 项目数据 (页 35)”部分；归档项目）。

再次更新重新归档后的项目。

5.2.10 备份用户自定义的状态显示画面。

如果在 PCS 7 V8.1 之前的版本中创建用户自定义扩展状态显示的状态显示时已使用自己

的画面，则应该将这些画面（EMF 文件）保存在单独的文件夹中。

步骤

1. 在 Windows 资源管理器中打开 OS 项目文件夹中的“GraCS”文件夹。

2. 为自己的画面创建一个文件夹。

3. 将使用的画面（EMF 文件）复制到新建文件夹中。

5.2.11 备份许可证密钥和授权

简介     

在更改操作系统或使用新 PC 站之前，必须对存储在硬盘上的许可证密钥/授权进行备份。

说明

可将所有许可证密钥备份到许可证密钥 U 盘（从 PCS 7 V7.1 开始提供）。

必须将授权传送到许可证密钥磁盘/多授权磁盘中。

用于备份许可证密钥的程序

使用自动化许可证管理器实现此目的。 

说明

安装操作系统后，可使用“自动化许可管理器”程序重新安装备份许可证密钥。

只有相应 PC 站上提供了要更新的许可证密钥时，才能升级许可证密钥（升级许可证密钥

和 PowerPack 许可证密钥）。

准备软件更新

5.2 必要的准备工作

使用新功能的软件更新
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更多信息

● 自动化许可证管理器的在线帮助

● WinCC 信息系统 > 授权在线帮助

准备软件更新

5.2 必要的准备工作

使用新功能的软件更新
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修改硬件 6
6.1 更新硬件概述

步骤概述

步骤 操作 ES OS 服务

器

OS 客
户端

AS

8 准备进行硬件替换 (页 46)    X

9 更新和替换硬件 (页 47)    X

6.2 规划和准备

如果要使用 PCS 7 V8.1 的新功能，PCS 7 工厂中过程控制系统的所有硬件组件（模块）

都必须符合该 PCS 7 版本的要求。  

更新或替换硬件组件的必要性

要确定是否需要更新硬件组件，可参考《PCS 7；已发布的模块》(PCS 7; Released 
Modules) 文档。 如果存在早期的产品发行版本，就不会自动启用该新 PCS 7 的功能。 

如果需要替换模块，请与西门子代理联系。

分析结果

完成硬件分析后可能出现以下情况：

● 模块可继续全范围使用。

● 模块可进行更新。

● 必须用新模块替换当前模块。

注意

更新或替换

要更新或替换组件，可能需要 AS 处于 STOP 状态。

示例： 在 CPU 固件更新期间或将工厂总线从 PROFIBUS 更改为“工业以太网”时。

使用新功能的软件更新
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6.3 如何进行硬件替换的准备工作

读取模块信息的选项

可在 HW Config 中读取有关以下模块的信息：

组件 有关信息

网络组件 菜单命令“对象属性 > 诊断：NCM S7 诊断”

(Object Properties > Diagnostics:NCM S7 Diagnostics)

CPU 菜单命令“对象属性”(Object Properties)

接口模块 
● IM 153
● IM 157
● IM 151

菜单命令 CPU >“模块信息”(Module information)

可在前面板的右下侧找到接口模块（IM）产品版本。

基本步骤

如果要替换 AS 中的硬件，则需要执行下列任务：

1. 分析所用模块的实际状态。

2. 定义所需状态：
定义系统未来应具有的结构。 定义未来的自动化目标，并使这些目标符合《PCS 7；已发布
的模块》文档中的要求。 
不同模块的更多相关信息，可参考文档《过程控制系统 PCS 7；PCS 7 PC 组态》(Process 
Control System PCS 7; PCS 7 PC Configuration)。

3. 进行模块规划：
生成规划文档，规定以下内容：

– 应保留的工厂部分

– 应扩展的工厂部分

– 应该仍可使用的旧模块

– 为使用 SIMATIC PCS 7 V8.1 的所有功能而应以新模块升级的工厂部分

通过 Internet 提供的专门信息

固件更新和相应更新的专门信息，可参考 Internet 上的：

http://www.siemens.com/automation/service (http://www.siemens.com/automation/
service) 

选择“搜索”(Search)，并在搜索窗口中输入“CP1623 firmware update”之类的内容。

修改硬件

6.3 如何进行硬件替换的准备工作

使用新功能的软件更新
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6.4 如何执行更新和替换硬件

简介

下表概述了可能需要进行的硬件更新。有关该步骤的详细分步说明，请参见手册《过程控

制系统 PCS 7；服务支持和诊断》(Process Control System PCS 7; Service Support and 
Diagnostics)。

硬件更新及补充信息总览

硬件更新，硬件替换 基本步骤 更多相关信息……

更新 CPU 操作系统 1. 检查模块的类型和产品版本。

2. 如有需要：

更新或更换模块。

手册《过程控制系统 PCS 
7；服务支持和诊断》

(Process Control System 
PCS 7; Service Support and 
Diagnostics) 的“更新 CPU 
操作系统”部分。

CP 443-5 Extended 
的固件更新

1. 检查模块的类型和产品版本。

2. 如有需要：

更新或更换模块。

手册《过程控制系统 PCS 
7；服务支持和诊断》

(Process Control System 
PCS 7; Service Support and 
Diagnostics) 的“CP 443‑5 
Extended：固件更新”部分。

CP 443‑1 的固件更

新

1. 检查模块的类型和产品版本。

2. 如有需要：

更新或更换模块。

手册《过程控制系统 PCS 
7；服务支持和诊断》

(Process Control System 
PCS 7; Service Support and 
Diagnostics) 的“CP 443‑1：
固件更新”部分。

更换 IM 153‑2 和 
IM 157

1. 检查模块的类型和产品版本。

2. 如有需要：

更新或更换模块。

3. 考虑必需的总线模块。

手册《过程控制系统 PCS 
7；服务支持和诊断》

(Process Control System 
PCS 7; Service Support and 
Diagnostics) 的“更新接口

模块 (IM)”部分。

修改硬件

6.4 如何执行更新和替换硬件
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硬件更新，硬件替换 基本步骤 更多相关信息……

Y 耦合器的固件更新 1. 检查模块的类型和产品版本。

2. 如有需要：

更新或更换模块。

3. 此外，请考虑必需的总线模块。

手册《过程控制系统 PCS 
7；服务支持和诊断》

(Process Control System 
PCS 7; Service Support and 
Diagnostics) 的“更新接口

模块 (IM)”部分。

更换诊断中继器 1. 检查模块的类型和产品版本。

2. 如有需要：

更新或更换模块。

● 部件编号为 
6ES7 972‑0AB01‑0XA0  
的诊断中继器支持 PCS 7 
V6.0 引入的功能。

● 部件编号为 
6ES7 972‑0AB00‑0XA0  
的诊断中继器不支持 
PCS 7 V6.0 引入的功能。

更多信息

更多相关信息，可参考以下文档：

在 Windows“开始”(Start) 菜单的“SIMATIC > 产品信息”(SIMATIC > Product information) 
子菜单中，在相应的语言文件夹内：

● 文件 PCS 7-WhatsNew.wri

在 Windows“开始”(Start) 菜单的“SIMATIC > 文档”(SIMATIC > Documentation) 子菜单

中，在相应的语言文件夹内：

● 文档《PCS 7 - 已发布模块》

● 手册《过程控制系统 PCS 7；PCS 7 PC 组态》(Process Control System PCS 7; PCS 
7 PC Configuration)

● 手册《STEP 7；通过 CiR 在运行期间修改系统》

● 手册《过程控制系统 PCS 7；服务支持和诊断》

修改硬件

6.4 如何执行更新和替换硬件
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ES 和 OS 上的 PCS 7 安装及设置 7
7.1 ES 和 OS 上的安装和设置概述

步骤概述  

步骤 操作 ES OS 服务

器

OS 客
户端

AS

10 准备 PC 站 (页 49) X X X  

11 安装 PCS 7 软件 (页 50) X X X  

12 设置操作模式“组态模式”/“PG 模式” (页 56) X X   

13 组态并下载 PC 站 (页 57) X X X  

14 安装附加 PCS 7 库 (页 62) X    

15 安装附加非标准库 (页 63) X    

16 在 OS 上安装附加面板  X   

参见

如何将 CAS 替换为 PH (页 100)

7.2 准备 PC 站

准备 PC 站   

其它步骤取决于要更新的 PC 站上的操作系统。

使用新功能的软件更新
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建议 

请使用最新批准用于 PC 站（工作站和服务器）的操作系统。

● 有关网络组态方面的信息，请咨询网络管理员。

● 有关备份数据的信息，可参考手册《过程控制系统 PCS 7；服务支持和诊断》

● 有关安装和组态 PC 站的信息，请参见《过程控制系统 PCS 7；PCS 7 PC 组态》

(Process Control System PCS 7; PCS 7 PC Configuration) 手册的“安装操作系统”部

分。

说明

重新安装操作系统

如果操作系统分区不包含以下任何重要数据，则可直接重新安装操作系统。

● 许可证密钥 
● 项目数据

● 归档文件 

如果可能，应完全从头开始安装 PC 站。

更多信息

● 手册《过程控制系统 PCS 7；PCS 7 PC 组态》(Process Control System PCS 7; PCS 
7 PC Configuration)

● 有关获准的操作系统的相关信息，请参见《过程控制系统 PCS 7；PCS 7 自述文件》

(Process Control System PCS 7; PCS 7 Readme)文档（Internet 版本）。

7.3 如何安装 PCS 7

要求

● 已备份 PCS 7 项目数据。    
有关如何备份项目数据的详细信息，请参见《过程控制系统 PCS 7；服务支持和诊断》

(Process Control System PCS 7; Service Support and Diagnostics) 手册中的“确保可

用性，数据备份”小节。

● 硬件规划和硬件更新已完成。

● 已完成必要的准备工作。

ES 和 OS 上的 PCS 7 安装及设置

7.3 如何安装 PCS 7

使用新功能的软件更新
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● 已更新待更新 PC 站的操作系统。

有关获准的操作系统的信息，请参见文件《过程控制系统 PCS 7；PCS 7 自述文件》

(Process Control System PCS 7; PCS 7 Readme) 文件。

● 参阅《过程控制系统 PCS 7；PCS 7 自述文件》(Process Control System PCS 7; PCS 7-
Readme) 文件中的最新信息。

– 硬件和软件要求以及安装信息

– 如果使用  INTEL 网络适配器，请安装适合设备类型和操作系统版本的驱动程序。 您
可从单独订购的“PCS7 V8.x 软件支持包”（编号 6ES7 650‑4xx08‑0YT8）中，“PCS 
7 软件支持与工具”DVD 2014.02 中的“01_Drivers\NETWORK\Intel”文件夹中找到

该信息。

– 有关 SIMATIC PCS 7 BOX 自动化系统软件的信息：

必须为 SIMATIC PCS 7 BOX 和 SIMATIC PCS 7 AS RTX 更新安装时间同步软

件。 

说明

项目受密码保护时的软件更新

项目受密码保护时的软件更新要求在 ES 上装有 SIMATIC Logon。

说明

归档服务器

● 必须通过 Process Historian 替换中央归档服务器 (CAS)。 
有关移植的信息，请参见“如何将 CAS 替换为 PH (页 100)”部分。

● Process Historian 和 OS 服务器的启动顺序
如果是在激活 OS 服务器后运行 Process Historian，则需要重启 
OS 服务器以建立到 Process Historian 的连接。

SIMATIC PDM

如果使用 PCS 7 的维护站或者项目包含通过 SIMATIC PDM 组态的智能现场设备，请在工

程师站上安装 SIMATIC PDM。必须在工程师站上安装 PDM 服务器才支持完整的资产管理

功能。

请参阅自述文件中关于 SIMATIC PDM 最新版本的信息和要求。

说明

安装 SIMATIC PDM
如果使用低于 V8.0 SP1 版本的 PDM，并且要执行更新安装，则需要在安装前卸载旧版本

的 PDM。
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安装 PCS 7

1. 将 Process Control System; SIMATIC PCS 7 DVD 插入 DVD 驱动器。

2. 选择“安装”(Install) 安装类型。
可以对已安装的 PCS 7 软件使用更新功能。
有关所需软件安装的详细信息，请参见文档《过程控制系统 PCS 7；PCS 7 PC 组态》
(Process Control System PCS 7; PCS 7 PC Configuration) 中的“如何安装 PCS 7 软件”
部分。

说明

安装期间，将多次出现同一条消息，提示您重新启动 PC。 请重启 PC。 随后会自动继

续安装。

3. 将备份副本（如果存在）中的旧项目数据恢复到 PC。

说明

更改项目路径所需的访问权限

“项目/多重项目的存储位置”(Storage location for projects/multi-projects) 中的项目路径

默认设置为“SIEMENS\STEP7\S7Proj”，并且为该项目路径设置了所有必需的访问权

限。

如果使用其它项目路径，则需要使用“SimaticRights.exe”工具设置必需的访问权限。

更多相关信息，请参见《过程控制系统 PCS 7；PCS 7 PC 组态》(Process Control 
System PCS 7; PCS 7 PC Configuration) 手册中的“如何设置项目路径的访问权限”

部分。

库

自 PCS 7 V8.0 起，PCS 7 的库随各个 PCS 7 版本一起更新。 默认情况下，会安装下列

库：

● PCS 7 基本库

包含 PCS 7 的 PCS 7 基本库中的块。PCS 7 基本库是使用 PCS 7 库和高级过程库的

先决条件。

● 高级过程库

包含 PCS 7 的高级过程库中的块。

说明

使用附加库

如果要与 PCS 7 Library 7.1.3 一起使用高级过程库，则还必须安装 PCS 7 DVD 上提供的

库。 相关信息，可参考以下部分：

● “安装附加 PCS 7 库 (页 61)”部分

● “如何安装附加 PCS 7 库 (页 62)”部分
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OS Web 选件

● Web 服务器

安装 Web 服务器后，必须运行 Web 组态器。

● Web 客户端

更新 PCS 7 Advanced Faceplates 的插件。

– 可以在 WebNavigator 客户端上更新软件（无需预先删除）。

– 使用 WebNavigator 诊断客户端时，必须先卸载软件，然后重新安装软件。

– 更新 Web 客户端上的现有插件。

Microsoft SQL Server

自 PCS 7 V8.1 起，PCS 7 的任何组态都不需要 Microsoft SQL Server 2005。 

如果在 PC 上安装了 Microsoft SQL Server 2005，但对工厂并没有什么具体的用途，则应

在 PCS 7 V8.1 的更新安装后卸载该软件。可以在控制面板中找到所需的菜单命令。

更多信息

● 《过程控制系统 PCS 7；PCS 7 自述文件》(Process Control System PCS 7; PCS 7 - 
Readme) 文件（请参见“前言 (页 9)”）

● 手册《过程控制系统 PCS 7；PCS 7 PC 组态》(Process Control System PCS 7; PCS 
7 PC Configuration)

7.4 如何实现 PC 站之间的加密通信

更改通信访问保护

典型情况有：

● PC 站软件更新

● 在非冗余组态中切换到加密通信

● 在冗余组态中运行期间切换到加密通信

● 在运行期间更改加密通信设置（例如，更改密码）。
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说明

通信连接中断

只有以下 PC 站之间的通信连接不可以任何方式发生中断时，才需要激活下文介绍的移植

模式： 
● 支持通信访问保护的 PC 站 
● 不支持通信访问保护的 PC 站 

激活移植模式 

如果要在系统的过程模式下更改通信访问保护，则必须按以下顺序执行操作：

1. 为所有 PC 站临时启用“移植模式”(migration mode) 选项，以便进行下一步骤。

2. 在激活不带移植模式的安全通信前，需评估潜在影响。

注意

系统中的安全通信

启用只进行加密通信前，必须确保：

● 所有需要的 PC 站上均已启用移植模式。

● 所需的全部 PC 站上均已启用加密通信功能。

3. 为所有 PC 站临时禁用“移植模式”(migration mode) 选项，以便进行下一步骤。

对 PC 站使用安全通信

1. 在 Windows 资源管理器的树形视图中，选择 PC 站上的“SIMATIC Shell”文件夹。 

2. 从快捷菜单中选择“设置...”(Settings...) 命令。 
将打开“通信设置”(Communication Settings) 对话框。

3. 启用“使用加密通信”(Use encrypted communication) 选项。 
将打开“设置 PSK”(Set PSK) 对话框。

说明

更改 PSK
启用“设置 PSK”(Set PSK) 选项后，可以更改 PSK。单击“设置”(Set) 按钮。

请注意文档《过程控制系统 PCS 7；PCS 7 PC 组态》(Process Control System PCS 
7; PCS 7 PC Configuration) 中的“如何更改加密通信的 PSK”部分。

4. 输入具有高密码强度的字符作为密钥。 
密钥必须至少 8 个字符，并且包括大/小写字母、数字和符号。 

5. 确认输入。 单击“确定”(OK)。

6. 如果要使用可用端口而非默认分配的端口，可以指定入站端口。
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7. 检查“移植模式”(Migration mode) 复选框的设置。

说明

请注意文档《过程控制系统 PCS 7；PCS 7 PC 组态》(Process Control System PCS 
7; PCS 7 PC Configuration) 中的“更改加密通信时如何使用移植模式”部分。

8. 单击“确定”(OK)。

更多信息

● 请注意文档《过程控制系统 PCS 7；PCS 7 PC 组态》(Process Control System PCS 
7; PCS 7 PC Configuration) 中的“如何访问子网外的 PC 站”部分。

7.5 更新 SIMATIC PCS 7 AS RTX

更新包

您需要将下列产品用于更新 SIMATIC PCS 7 AS RTX ：

PCS 7 AS RTX V8.1 更新包 

基本步骤

1. 备份用户和网络设置

2. 备份许可证密钥

3. 按照 SIMATIC PCS 7； PCS 7 AS RTX V8.1 更新包产品信息更新 SIMATIC PCS 7 AS RTX

4. 创建用户和网络设置

5. 加载 SIMATIC PCS 7 AS RTX

更多信息

● 产品信息 SIMATIC PCS 7；SIMATIC PCS 7 AS RTX
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7.6 处于组态模式和 PG 模式的模块

操作模式

始终都要区分两种操作模式：

● 处于组态模式的模块

● 处于编程设备 (PG) 模式的模块

处于“组态模式”的模块

只能将组态的连接从 NetPro 传送到处于“组态模式”的模块。 使用此操作模式时，

SIMATIC NET 提供的所有日志均可用。 因此，我们建议使用此设置。

按“组态模式”设置的要求，PCS 7 项目中必须包含一个 SIMATIC PC 站，该站装有用于

工程师站 (ES) 的 WinCC 应用程序。 检查 PCS 7 项目是否已满足这一要求。

处于“PG 模式”的模块

在“PG 模式”下，可为网络适配器分配参数。 使用“设置 PG/PC 接口”组态程序，可分

配与网络相关的参数（如站地址和传输速率）。 只能在计算机本地进行此组态。

在此操作模式下，不能与 PC 站进行任何通信。

要求

● 已组态 PC 站的网络地址和网络设置。

● PC 站的组态与 HW Config 以及站组态编辑器中的一致。

● PC 站的组态已加载到 PC 站上。

● 已加载 PC 站的连接数据。

步骤

1. 在 Windows 的“开始”(Start) 菜单中，选择 SIMATIC > SIMATIC NET 子菜单中的菜单命
令“通信设置”(Communications settings)。

2. 在树形视图中，选择“模块”(Modules) > <“系统总线上的网卡”(Network Card on System 
Bus) > >“常规”(General) 文件夹。
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3. 从“模块模式”(Module Mode) 下拉列表框中选择相应条目。

4. 单击“应用”(Apply)。

说明

对于过程模式，网络适配器（网卡或通信处理器）必须设置为“组态模式”(Configured 
mode)。

说明

使用多个网络适配器的 PC 站
对于使用多个网络适配器的 PC 站，网络适配器可按修改后的顺序进行识别。 对于使用多

个网络适配器的 PC 站需要考虑此因素并在 HW Config 中相应修改组态。 

7.7 如何组态和下载 PC 站

简介

工程师站的网络适配器（以太网）的项目特定网络设置将直接下载到 PC 站。

要求

● 已在每个 PC 站上安装以下项：

– 操作系统

– PC 站的特定软件（例如，工程师站，OS 服务器）

● 所有要下载的 PC 站都至少通过一个网络链接到工程师站。

● 终端总线上的通信协议已设置为 TCP/IP。

● 已建立了网络（终端总线和系统总线）。 PC 站的网络地址已组态。

● 每个 PC 站上的 PC 站访问点设置如下：“S7ONLINE：= PC 内部（本地）”(S7ONLINE:= 
PC internal (local))。

步骤

说明

组态和下载其它 PC 站前，请首先对工程师站执行以下步骤。
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1. 在 SIMATIC Manager 中，打开 PCS 7 项目。

2. 在组件视图中，选择目标计算机。

3. 选择菜单命令 CPU >“组态”(Configure)。
将打开“组态”(Configure) 对话框。

4. 在“本地网络连接”(Local Network Connection) 下拉列表框中，选择用于访问目标计算机的
网络连接。

5. 单击“更新”(Update)。
将更新可访问计算机列表。
项目中选中的 PC 站将输入到“目标计算机”(Target computers) 区域中。

6. 选择所需的目标计算机（PC 站）。

说明

如果所选的 PC 站未出现在列表中，则表明有网络问题或项目组态中出现错误。

7. 单击“组态”(Configure)。
对话框“组态： <选定的站>”（Configure: <Selected Station>）将打开。

8. 在 “组态：目标计算机”(Configure: Target Computer) 对话框中单击“确定”(OK)。

9. 在“信息”(Information) 对话框中单击“确定”(OK)。 组态数据传送到 PC 站。 要激活网络
连接，还必须将网络设置下载到此 PC 站。 完成的“组态”(Configuration) 步骤显示在对话
框消息行中。

10.单击“关闭”(Close)。

11.对于步骤 2 中选定的计算机，选择菜单命令 CPU >“下载”(Download)。
将打开“下载到当前项目中的 CPU”(Download to CPU in Current Project) 对话框。

说明

PC 站中组态的以太网网络适配器的网络地址必须与目标系统中的预设地址相匹配。

12.当对话框提示您将要覆盖组态数据时，请作出如下响应：

– 初始调试期间，单击“是”(Yes)。
– 如果 PC 站处于过程模式，只可在允许通信中断时单击“是”(Yes)。
将打开“停止目标模块”(Stop Target Module) 对话框。

13.在“停止目标模块”(Stop Target Module) 对话框中，单击“确定”(OK) 进行确认。
将打开“下载”(Download) 对话框。

14.单击“确定”(OK) 进行确认。
将执行下载。
应用组态后，即可运行 PC 站。

15.对所有 PC 站重复步骤 2 至 14。
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在总线（工业以太网）上切换日志

说明

操作期间不得禁用 TCP/IP 协议或 ISO 协议。 因为组态的操作模式需要这些协议！

如果必须将系统中的总线切换为其它协议（例如，从 TCP 协议切换为 ISO 协议），则必

须在工程师站上临时设置一个混合协议（TCP 和 ISO）。 然后将组态数据下载到 AS 和操

作员监控系统。

更多信息

● 《SIMATIC NET；调试 PC 站 - 手册和入门指南》(SIMATIC NET; Commissioning PC 
Stations - Manual and Getting Started) 手册

7.8 PC 网络中的传输率和操作模式

简介

为在网络中进行通信，请确保对于所有网络节点而言，以下参数的设置保持一致：       

● 传输速率

● 运行模式

自动识别传输速率和操作模式

术语自动协商表示自动识别和协商传输速率和操作模式（全双工/半双工）。

● 全双工是一种双向数据交换操作模式，在此模式下，通信伙伴可在传输链路上相互独立

地发送数据。

● 半双工也是一种双向数据交换操作模式，在此模式下，一次只能有一个通信伙伴在传输

链路上发送数据。

要求

根据其出厂设置，PCS 7 中使用的 Siemens 设备会自动识别（协商）传输速率和操作模式

参数。

只有当网络通信中的必需节点，没有自动协商设置时，才需要更改此设置。
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为网络节点分配参数

使用位置 网络节点 调用参数分配对话框的步骤 参数设置

PC 通信处理器 
● CP 1613
● CP 1623
● CP 1628

1. 在 Windows“开始”(Start) 菜单中，

选择 SIMATIC > SIMATIC NET 子
菜单，然后选择菜单命令“组态 
PC 站”(Configure PC-Station)。

2. “PC 站”(PC Station) >“模块”
(Modules) >“网络参数”(Network 
Parameters)

为双工模式和传输速率选

择选项

PC INTEL  网络适配器设置

（或类似的标准网络适配器）

1. 在 Windows 控制面板中，选

择“管理工具 > 计算机管理 > 设备

管理器 > 网络适配器”
(Administrative Tools > Computer 
Management > Device Manager 
> Network adapters)

2. 选择网卡

3. “文件”(File) >“属性”(Properties)
4. “高级”(Advanced) 选项卡

设置属性值。

属性的典型名称（取决于

使用的网络模块）：

● 速度和双工模式 
(Speed and duplex 
mode)

● 链接速度和双工 (Link 
speed & duplex)

交换机 SCALANCE X400

SCALANCE X200

ESM

OSM

● 通过 Internet Explorer 调用交换机

的参数分配对话框（基于 Web 的
管理）：

http : \\<TCP-IP 地址>
● 通过 telnet（DOS 窗口：telnet）

组态

端口组态

AS 通信处理器 CP 443-1 ● HW Config： CP443-1  属性 >“选
项”(Options) 选项卡 >“各网络设

置”(Individual network settings) 组
“传输介质/双工”(Transmission 
medium/duplex) 下拉列表

默认为“自动设置”
(Automatic Setting)

更多信息

● 操作说明《SIMATIC NET；工业以太网交换机 SCALANCE X-400》(SIMATIC NET; 
Industrial Ethernet Switches SCALANCE X-400)

● 组态手册《SIMATIC NET；工业以太网交换机 SCALANCE X-400》(SIMATIC NET; 
Industrial Ethernet Switches SCALANCE X-400)
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7.9 安装附加 PCS 7 库

概述

更新软件时，请遵守有关 PCS 7 库的以下规范： 

将软件更新到 PCS 7 V8.1 后，如果要在 PCS 7 项目中继续使用此 PCS 7 Library 的块，

则随后必须在工程师站上安装 PCS 7 Library 。

● 如果既要使用 APL V8 块，又要使用 PCS 7 标准块，则需要使用 PCS 7 Library 中存储

的块来更新“ChnBlocks for PCS7 V8”文件夹中的块。 
为此，还需要安装 PCS 7 库。 
相应安装程序位于 DVD2 Process Control System; SIMATIC PCS 7 的文件夹 
"Additional_Products\PCS7LIBRARY__V7.1<...>"。

● 使用 PCS 7 库
如果要安装新的 PCS 7（安装类型“安装”），则需要遵守以下说明：

– 如果要使用在 PCS 7 V8.1 下进行更新的项目中的 PCS 7 库，则在安装全新的 PCS 
7 后，需要在以下 PC 站上安装 PCS 7 V7.1 的面板（PCS 7 面板）：

- 工程师站

- 所有操作站

– 相应安装程序位于 DVD2 Process Control System; SIMATIC PCS 7 的文件夹 
"Additional_Products\PCS7Faceplates__V7.1+SP3" 下。

基本安装步骤

在“如何安装附加 PCS 7 库 (页 62)”小节介绍了相关操作步骤。

相关基本步骤，请参见组态手册《过程控制系统 PCS 7；工程组态系统》(Process Control 
System PCS 7; Engineering System)。 

ES 和 OS 上的 PCS 7 安装及设置

7.9 安装附加 PCS 7 库

使用新功能的软件更新

维修手册, 03/2015, A5E32786300-AB 61



7.10 如何安装附加 PCS 7 库

说明

后安装或删除 PCS 7 库
如果在安装 PCS 7 后安装或删除旧版本的 PCS 7 库、PCS 7 基本库或 PCS 7 高级过程

库，则随后必须安装程序安装当前版本的 PCS 7 基本库或 PCS 7 高级过程库。

请使用 PCS 7 安装程序安装所需库，不可使用相关库产品的安装程序安装。 例如，安装 
DVD2 Process Control System; SIMATIC PCS 7 的文件夹 Additional_Products  下的 
PCS 7 库时就需要注意这一点。

有关库版本（包括更新）的信息，请参见文件《过程控制系统 PCS 7；PCS 7 自述文件》

(Process Control System PCS 7; PCS 7 Readme)（请参见“前言 (页 9)”）。

要求

● 安装了包含所需组件的操作系统。  

● 已安装 PCS 7。

● 关闭了所有的应用程序。

● 所需库所需的软件位于 Process Control System; SIMATIC PCS 7 DVD 上。

步骤

以下列步骤为例。 

1. 运行“SETUP”程序。
相关库和相应的安装程序位于 DVD2 Process Control System; SIMATIC PCS 7 的 
"Additional_Products" 文件夹下。

2. 选择安装语言。

3. 单击“下一步”(Next)。

4. 按照安装向导中的说明进行操作，然后关闭安装程序。

5. 安装所有所需的库之后，需要使用 PCS 7 的安装程序继续安装最新的 Process Control 
System; SIMATIC PCS 7 DVD 上提供的下列库：

– PCS 7 高级过程库 (APL)
– PCS 7 基本库
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更多信息

随交付的 PCS 7 库提供有：

● PCS 7 Basis Library: bli-readme.rtf 文件

● PCS 7 Library: LIB-Readme.wri 文件

● PCS 7 Advanced Process Library: APL-Readme.rtf 文件

7.11 使用高级过程库有哪些要求？

使用高级过程库 (APL)

要使用 PCS 7 V8.0 或更高版本中提供的功能，应使用以下库：

● PCS 7 高级过程库 (APL)

● PCS 7 基本库

只有在安装了 PCS 7 基本库的情况下才能使用 PCS 7 高级过程库 (APL, Advanced Process 
Library)。

说明

升级 PCS 7 并要使用新功能时，必须始终升级所有库。 不允许只为 PCS 7 项目中的一个

库使用新功能！

转换为 APL 块需要重新执行应用特定的组态。 

更多信息

● “使用 APL (页 117)”部分

7.12 如何安装附加的非标准库

简介

如果正在 PCS 7 项目中使用要更新的库并且想要继续使用，而这些库在 PCS 7 中不是标

准库或是包含已修改的块，请留意本部分的内容。
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要求

已在 SIMATIC 管理器中使用菜单命令“文件”(File) >“归档”(Archive) 对库进行了归档。

步骤

1. 启动 SIMATIC 管理器。 PCS 7 项目不必打开。

2. 在 SIMATIC 管理器中，选择菜单命令“文件”(File) >“重新获取”(Retrieve)。
将打开“恢复 - 选择归档”(Retrieving - Select Archive) 对话框。

3. 指定归档库的路径。
单击“打开”(Open)。
将打开“选择目标目录”(Select Destination Directory) 对话框。

4. 设置目标目录。

5. 单击“确定”(OK)。

说明

在 AS 上，仅可加载一个 PCS 7 版本的 AS 块。

更多信息

有关修改库的信息，请参见以下文档：

● 在线帮助 WinCC 面板设计器

7.13 如何更新用户特定的 APL 面板 

简介

对按照 APL 类型指南创建的 APL 面板，必须进行一些修改。 请参阅 APL 自述文件中的说

明（见 Process Control System; SIMATIC PCS 7 ; DVD_2; 
Additional_Products\PCS7ADVLIBRARY__V7.1<...> 文件夹）。

说明

需要考虑到的是，对于替换过的对象，您需要重新输入其参数化数据。

要求

Advanced Process Library V7.1 SP5 Upd5
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步骤

用 @PCS7ElementsAPL.pdl 画面中的相应对象替换基本面板画面（例如 
@PG_MyAPLFP.PDL）中的下列对象。

● 用“APL_PIN_BUTTON”（版本不低于 10061101）替换“AlwaysOnTop”对象。

● 用“ObjCollection”（版本不低于 10102501）替换“ObjCollection”对象。

● 用“@Faceplate”（版本不低于 10110501）替换“@Faceplate”对象。

● 复制 APL SP5 的 @PG_PIDConL.pdl 画面中的完整 C 脚本 ViewWindow/Height/
OnPropertyChanged，并完全替换自身基本画面中的脚本 ViewWindow/Height/
OnPropertyChanged。

● 复制 APL SP5 的 @PG_PIDConL.pdl 画面中的完整 C 脚本 ViewWindow\PictureName
\OnPropertyChanged，并完全替换自身基本画面中的脚本 ViewWindow\PictureName
\OnPropertyChanged。

说明

需要考虑的是，对于替换过的对象，您需要按照 APL 类型指南章节 1.3.2 中的说明重新

输入其参数化数据。

● 更改以下参数分配：

– 在“@Faceplate”对象中，将“Firstview”属性改为新的画面名称，如

“PG_MyAPLFP_Standard.PDL”。

– 在“ObjCollection”对象中，将“BlockType”属性改为新面板类型的名称（服务器名

称），如“MyAPLFP”。

说明

使用可控制对象时，必须在“PermissionTag”或“LinkTag3”属性中创建变量链

接。 APL 类型指南章节 1.3.7 中介绍的参数分配将不再有效。 
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ES 上 PCS 7 项目的修改 8
8.1 更新 PCS 7 项目

基本步骤

本部分介绍如何更新 PCS 7 项目，以便在 SIMATIC PCS 7 中使用。PCS 7 项目是在 ES 
上离线模式下更新的。 这样，就不会影响到系统的运行。 只有下面列出的所有更新步骤执

行完毕后，才会装载目标站。 关于下载的更多信息，请参见组态手册《过程控制系统 PCS 
7；工程师站》。   

在 ES 上完成以下所有更新步骤后，继续组态已更新的 PCS 7 项目时，可能需要完成一些

特定步骤，如编译 CFC 图表以及将更改或整个项目下载到 AS 中。

8.2 常规修改

8.2.1 项目常规修改概述

步骤概述    

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

17 使用项目移植器更新 OS (页 67) X    

18 检查 PH 一致性 (页 69) X    

8.2.2 如何更新操作员站的组态

自 PCS 7 V8.0 SP1 起，SIMATIC Manager 可自动检测多重项目或项目中的 OS 组态是否

与安装的 PCS 7 版本一致。         
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要求

● 当前 PCS 7 版本低于 PCS 7 V7.1 SP3 的项目必须首先更新为 PCS 7 V7.1 SP4。

● 仅限受密码保护的项目：

在以下操作期间禁用密码保护。

步骤 

对给定的 OS 项目执行以下步骤：

1. 在 SIMATIC Manager 的组件视图中打开项目/多重项目。

2. 选择所需的 OS 项目。
如有必要，系统将打开“移植器”(Migrator) 对话窗口。
将显示“需要移植...”(Migration is required ...) 消息。

3. 单击“是”(Yes)。

说明

拒绝移植

如果拒绝移植，将无法更改或加载 OS 项目。 
随时都可以开始移植。 为此，选择菜单命令“选项 > 移植 OS 项目”(Options > Migrate 
OS projects)。

4. 在“移植器”(Migrator) 对话框中检查项目语言设置。 如有必要，设置成创建项目时所使用
的语言。
建议：
对话框中无需进行任何设置。 
– 如果清除“仅移植数据库...”(Migrate database only...) 复选框，移植将持续相当长的

时间。 
– 移植在过程模式中排除的组件对过程模式没有任何影响。

5. 单击“下一步”(Next)。
更新多重项目/项目中包含的所有操作站的组态。

更新过程的持续时间

说明

根据范围大小，更新过程可能需要数小时。
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更多信息

● 在线帮助 WinCC 信息系统 > 移植

● 组态手册《过程控制系统 PCS 7；操作站》(Process Control System PCS 7; Operator 
Station)

8.2.3 更改多语言文本的组态

如果要使用其它界面语言，请注意以下信息。

更改多语言文本

如果希望在 PCS 7 中显示多种语言的文本（例如，消息文本或 OS 区域 ID），通常使用

导入/导出功能对多语言文本进行更改（菜单命令“选项”(Options) >“管理多语言文本”
(Manage Multilingual Texts) >“导出”(Export) 然后在完成更改后进行“导入”(Import)）。 

说明

如果使用这些功能在 CFC、SFC 或 PH 中更改各段文本，确保立即在所有位置编译这些文

本（例如，所有块类型和所有块副本）。 否则，可能出现不一致并且导致此文本显示为不

正确的语言版本。 

8.2.4 如何检查 PH 一致性

简介

此步骤可显示“工厂层级”中的所有数据是否一致。  

要求

● 已在 SIMATIC Manager 的工厂视图中打开项目。
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步骤

可对多项目或其中的各个项目执行以下步骤。

1. 在树形视图中，选择要检查的对象（例如，多项目）。

2. 选择“选项 > 工厂层级 > 检查一致性”(Options > Plant Hierarchy > Check Consistency) 
菜单命令。
将检查 PH。 
将打开“检查一致性 - 日志”(Check Consistency - Log) 对话框。

3. 更正所有发现的错误。

说明

如果需要有关可能错误的详细信息，请单击“检查一致性 - 日志”(Check Consistency – 
Log) 对话框中的“帮助”(Help) 按钮。

8.3 HW Config 中的修改

8.3.1 硬件修改概述

重要信息

在下列情况下，必须修改 PCS 7 组态数据：

● 某一模块被不同类型模块替换时。

● 更新 CPU 操作系统、或 CP 或 IM 的固件时。

● 如果切换到 Windows 7/Windows Server 2008 R2 操作系统，则需要在站组态编辑器

和 HW Config 中更新通信组件的版本。版本取决于目标站上安装的 SIMATIC NET 版
本。

– 自 Windows 7 和 Windows Server 2008 R2 起，安装 SIMATIC NET V12.x （例如，

对于 CP 16xx -> SW 8.1.1）。

– PCS 7 不再支持通信处理器 CP 1613 A1 。
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步骤概述

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

19 组态更换后的硬件 (页 71) X    

20 设置 CPU 属性 (页 72) X    

21 更新硬件配置 (页 72) 

（仅限使用 SIMATIC PCS 7 BOX RTX 或 
SIMATIC PCS 7 AS RTX 的项目）

X    

22 组态 PDM 服务器的地址 (页 73) 

（仅限使用 SIMATIC PDM V7.0 的项目）

X    

8.3.2 如何组态更换的硬件

在过程控制系统中更换模块或执行固件更新后，必须在 PCS 7 项目中更新硬件版本状

态。 

要求

● 已使用项目移植器更新 PCS 7 项目的操作站。

步骤

1. 打开 HW Config。

2. 将对象（例如，CPU：类型，固件版本 x.x）从硬件目录拖至 AS 组态表中的相应插槽。 
将显示下列系统消息： “是否要用组件...替换组件...？”

3. 检查硬件类型。

4. 单击“是”。

5. 选择菜单命令“站”(Station) >“保存/编译”(Save/Compile)。
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8.3.3 如何设置 CPU 属性

检查 CPU 属性的原因

更新 CPU 的固件版本时（例如在 HW Config 中），在更新期间某些参数可能不被接受，

并可能由默认值替换。 此时，将出现一条消息。 这种情况下，要检查 CPU 的属性设置并

在必要时进行修改。

要求

● 出现一条消息，表明替换模块时并非应用了所有参数。

● HW Config 已打开。

步骤

1. 在 HW Config 中，选择要在组态表中使用的 CPU。

2. 在右键快捷菜单中，选择菜单命令“对象属性”(Object Properties)。

3. 打开“诊断/时钟”(Diagnostics/Clock) 选项卡，然后检查“时钟”(Clock) 区域中的设置：

– “AS 中”同步的类型必须设置为“作为从站”(As slave)。
– “MPI 上”同步的类型必须设置为“无”(None)。

4. 打开“周期/时钟存储器”(Cycle/Clock Memory) 选项卡，然后检查设置：

– 如果使用的模块驱动程序为 PCS 7 V6.0 及更高版本，则必须选中“定期更新 OB1 
过程映像”(Update OB1 process image cyclically) 复选框。

– 在“I/O 访问出错时调用 OB85”(OB85 Call for I/O Access Errors) 下拉列表框中，选

择“仅限进入和离开错误”(Only for incoming and outgoing errors)。

5. 选择菜单命令“站”(Station) >“保存/编译”(Save/Compile)。

8.3.4 如何为 SIMATIC PCS 7 BOX RTX 和 SIMATIC PCS 7 AS RTX 更新硬件配置

对于采用 SIMATIC PCS 7 BOX RTX 或 SIMATIC PCS 7 AS RTX 的项目，必须执行下述

步骤。

替换 PC 站硬件配置中的自动化系统。

要求

● HW Config 中的 AS 不是最新版本（版本 3.3 或更低版本）

● 分配给主站系统的 CP 已知。
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步骤

1. 在 HW Config 中打开 PC 站（SIMATIC PCS 7 BOX RTX 或 SIMATIC PCS 7 AS RTX）。

2. 选择与分布式 I/O 连接的 PROFIBUS CP。

3. 选择“编辑”(Edit) >“主站系统”(Master system) >“断开连接”(Disconnect) 菜单命令。

4. 选择 CP。

5. 选择“编辑”(Edit) >“删除”(Delete) 菜单命令。

6. 在 HW Config 的机架中选择“Win LC RTX”CPU。

7. 转到 HW Config 中的“SIMATIC PC 站”(SIMATIC PC-Station) >“控制器”(Controller) > Win 
LC RTX 文件夹。

8. 双击对象“V4.4”。
将打开“插入...”(Insert ...) 对话框。

9. 单击“是”(Yes)。
控制器随即被替换。

10.转到 HW Config 中的“SIMATIC PC 站”(SIMATIC PC-Station) >“控制器”(Controller) > Win 
LC RTX > V4.4 文件夹。

11.选择所使用的 PROFIBUS CP（默认：CP 5613）。

12.将所选的 PROFIBUS CP 拖放到站窗口的控制器插槽中。
将打开“属性...”(Properties ...) 对话框。

13.从“子网”(Subnet) 列表中选择相关总线系统的条目。

14.单击“确定”(OK)。
将打开“插入主站系统”(Insert master system) 对话框。

15.从“子网”(Subnet) 列表中选择相关总线系统的条目。

16.单击“确定”(OK)。

17.选择菜单命令“站”(Station) >“保存并编译”(Save and Compile)。

8.3.5 如何组态 SIMATIC PDM 服务器

要求

● 已经创建了项目/多项目。

● 在工程师站上安装了 SIMATIC PDM（服务器）软件包。

说明

使用 SIMATIC PDM 的要求

要使用 SIMATIC PDM 版本，请满足以下条件。
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选择 PC 站的名称

说明

限制

必须遵守下列限制：

● 有效字符：[A-Z 0-9]{1,32}
● 仅使用大写字母。

● PC 站名称的第一个字符必须是字母。

● 最大长度： 32 个字符

说明

我们建议 PC 名称与站名称相同。

步骤

1. 在 SIMATIC Manager 中选择“选项”(Options) > SIMATIC PDM >“设置”(Settings) 命令。
将打开“SIMATIC PDM 设置”(SIMATIC PDM Settings) 对话框。

2. 选择“维护工作站”(Maintenance Station) 选项卡。

3. 转到输入域并输入已在其中定义了 MS 服务器的项目/多项目，或执行下列步骤：

– 在多项目中： 
单击“当前多项目”(Current Multiproject) 或“浏览”(Browse)。 可使用“浏览”
(Browse) 按钮选择当前项目。

– 对于项目： 
单击“当前项目”(Current Project) 或“浏览”(Browse)。 可使用“浏览”(Browse) 按
钮选择当前项目。

4. 单击“确定”(OK)。

5. 在 SIMATIC Manager 中打开组件视图。

6. 在项目中，选择要插入“PDM 服务器”(PDM Server) 对象的工程师站。

7. 在详细信息视图中双击“组态”(Configuration) 对象。
将打开 SIMATIC PC 站的硬件配置。
如果无法看到硬件目录，则选择“视图”(View) >“目录”(Catalog) 菜单命令。
将打开硬件目录。

8. 从文件夹的列表中选择“SIMATIC PC 站”(SIMATIC PC Station) >“PDM 服务器”(PDM 
Server)。

9. 将“PDM 服务器”(PDM Server) 对象拖放到工程师站的 PC 站。

10.选择菜单命令“文件”(File) >“保存”(Save)。

11.将组态下载到工程师站。
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使用 SIMATIC PDM 进行诊断的要求

只有在工程师站上激活了 SIMATIC PDM，才能在指定站（OS 客户端、维护服务器等）

的 PDM 设备上执行诊断。 这是下载组态后的默认方案。 

更多信息

● STEP 7 和 SIMATIC PDM 在线帮助

● 白皮书《SIMATIC；安全性概念 PCS 7 和 WinCC - 主文档》(SIMATIC; Security 
concept PCS 7 and WinCC - Main document)

8.4 NetPro 中的修改和 CFC/SFC 图表的转换

8.4.1 修改 OS 相关设置的概述

步骤概述

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

23 在 NetPro 中检查并修改连接数据 (页 75) X    

24 转换 CFC 和 SFC 图表 (页 77) X    

8.4.2 如何在 NetPro 中检查和修改连接数据

在 NetPro 中，检查目标站的组态：

● 连接数据

● 组态数据

● 更改操作系统后
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说明

操作系统更改

更改操作系统后，可能会按照不同顺序检测系统中的网络适配器。 这是因为操作系统的缘

故。 
对于使用多个网络适配器的系统需要考虑此因素并在 HW Config 中相应修改组态。

请在站组态编辑器和 HW Config 中更新通信组件的版本。版本取决于目标站上安装的 
SIMATIC NET 版本。

自 Windows 7 或 Windows Server 2008 R2 起，安装自 V12.x 起的 SIMATIC NET。 根据

所使用的网络适配器，在 HW Config 中选择以下版本的通信组件：

● 使用“IE 常规”标准网络适配器时：V8.2
● 使用通信处理器（如 CP 16xx）时： V8.1.1

要求

● ES 上的 PCS 7 项目已打开。

步骤

1. 在 SIMATIC Manager 中选择 PCS 7 项目。

2. 选择菜单命令“选项 > 组态网络”(Options > Configure Network)。
将打开 NetPro。

3. 选择菜单命令“视图 > 交互项目网络视图”(View > Cross-Project Network View)。
将显示交互项目网络视图。
通过该视图可在多重项目中的所有项目之间直接切换。

4. 检查与不同站的连接： AS-OS、AS-AS、ES-AS。 
禁用“交互项目网络视图”(cross-project network view) 后，可进行所有必要的更改。
如果要在 ES 上检查过程模式（运行时）的通信，必须组态 ES 和 AS 之间的连接。 这需要
执行下列步骤：

– 在 WinCC 应用程序的快捷菜单中，选择菜单命令“新建连接”(New Connection)。
– 选择目标： AS 或 OS。
– 选择连接。

– 选择连接的名称。

– 单击“确定”(OK)。
建议
为使连接易于识别，建议按照目标名称为连接分配默认名称。
示例： 
组态从 OS 到 AS_X 的连接。 
相应的连接名称可以是“ASX_connection”。
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5. 如果正在使用时间同步，必须检查 ES 和 OS 的网络适配器（例如通信处理器）的时间设
置。 双击 OS/ES 的网络适配器。 要实现时间同步，必须在“选项”(Options) 选项卡中选择
时钟模式。

6. 如果已在 NetPro 中进行更改，则必须通过“保存并编译全部”(Save and Compile All) 选项，
执行“保存并编译”操作。

8.4.3 如何转换 CFC 图表和 SFC 图表

要求

PCS 7 项目已在 ES 上打开。  

步骤

说明

必须为 PCS 7 项目中的所有 S7 程序执行此步骤。

1. 打开 CFC 图表，并移动其中包含的任何块。
此操作会使转换对话框立即打开。

2. 单击“是”。
将打开“转换格式”(Convert Format) 消息窗口。

3. 单击“是”。

4. 单击“确定”(OK)。

8.5 更新块

8.5.1 更新块的任务概述

步骤概述     

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

25 将对象从其它库复制到主数据库 (页 81) X    

26 完成主数据库 (页 82) X    
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步骤 操作 ES OS 服务

器

OS 
客户

端

AS

27 同步块 (页 86) X    

28 包含事件文本 (页 88) X    

29 导入操作员文本 (页 89) X    

30 修改操作员文本 (页 89) X    

31 组态在线趋势控件的限值 (页 84) X    

32 更新块类型 (页 90) X    

33 更新 SFC 块类型 (页 92) X    

34 编译 CFC 图表 (页 93) X    

8.5.2 新主数据库的集成

基本步骤

创建一个多项目也将创建一个空的主数据库。 将第一个 AS 中的所有块从要更新版本的

“离线”(Offline) 块文件夹复制到主数据库中。 然后，将主数据库的块与下一个 AS 的“离

线”(Offline) 块文件夹相比较。 如果其中包含未存储在主数据库中的其它块，则也会将这些

块复制到主数据库中。 重复执行此步一直到最后的 AS。

说明

以下信息适用于 PCS 7 项目中的 AS 块。 
● 在 SIMATIC 站上，仅可加载一个 PCS 7 版本的 AS 块。

● 始终只能将一个 PCS 7 版本的 AS 块插入主数据库中。

8.5.3 面板中消息文本的语言

面板中的文本

如果要将在面板上显示的、通过 ES 数据管理生成的消息，从默认语言（英语）转换为其

它语言（如意大利语或西班牙语），必须执行以下步骤：

● 将对象从其它库复制到主数据库

● 将项目中使用的块复制到主数据库
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● 编辑面板中的事件文本和操作员文本

● 更新项目中的块类型

块实例中的消息文本

通过复制块类型创建的块实例中的消息文本没有类型参考。

如果更新软件后添加了其它显示语言（如意大利语、西班牙语），这些已添加显示语言的

消息文本将在块类型的块实例中以英语显示。

在块导入中包含消息文本

如果要在块导入中包含消息文本，需在库（主数据库）中为块类型进行设置。

说明

整个 S7 程序中块类型的所有块实例的消息文本都将被覆盖！

更多信息

有关此内容的更多相关信息，可参考“如何在块导入中包含块类型的事件文本 (页 88)”部

分。

8.5.4 编辑面板文本

应用程序

在以下情况下，必须执行“通过导入文件修改操作员文本”(Adapting Operator Texts with 
Import File) 部分中的步骤：

● 要将面板上显示的文本从默认语言（英语）转换为另一种语言（如德语或法语）。

● 如果要保留项目原有的操作员文本。

块实例中的操作员文本

说明

如果在 CFC 图表的块实例中已对操作员文本进行修改，则再也不能通过导入块类型重新集

成操作员文本。 只能在块实例中更改操作员文本。
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8.5.5 从其它库复制对象的规则

复制规则

● 如果要将 PCS 7 库 提供的过程标签类型复制到主数据库，只需在“模板”(Templates) 
文件夹内选择所需的过程标签类型。 复制这些类型并将它们粘贴到主数据库的“图表”
(Charts) 文件夹中。   

● 如果从不同的库将块复制到主数据库，块可能会分配有不同的名称（和功能），但会分

配有相同的块编号。 如果出现了此种情况，则将打开一个对话框，在其中可以重新命名

块或同步其属性。

只有当块复制到“离线”(Offline) 块文件夹时，才可以对其重新命名（重新分配）。 

● 从库复制块时也会复制符号名。 如果是从 S7 程序而不是从库复制块，则符号名将会丢

失，随后必须在符号表中重新输入符号名。

说明

在 SIMATIC 站上，仅可加载一个 PCS 7 版本的 AS 块。

多实例块规则

● 对于使用块代码来调用其它块的块（多实例块），这些较低级的块也必须以正确的版本

复制。

在编译用户程序时会显示所有缺失的较低级 FB。

说明

请注意，编译用户程序时，ES 不会识别缺失的 FC。  
如果用户程序中缺少 FC，下载后 AS CPU 将进入 STOP 模式。

如有必要，可在单独的 CPU 上使用“简化的库”测试用户程序的可执行性。

● 多实例块的代码总是存储其调用块的编号。 使用 SIMATIC Manager 中的菜单命令“选

项”(Options) >“重新连接 ...”(Rewire ...) 可以编辑这些编号，从而更改程序代码本身。 
例外： 不能更改受保护的块的编号。

8.5.6 编辑操作员文本的规则

简介

修改默认文本时，应遵守以下规则。   
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规则

● 新文本的长度不得超过默认文本。 如果必须使用较长的文本，必须在面板上查看消息是

否正确显示。

● 由于空格或国际代码用作默认值，故转换时不必考虑“s7_unit”属性。

● 如果需要多语言文本，可使用 WinCC 编辑器“文本库”将这些文本翻译为其它语言。

因而在 SIMATIC Manager 中，必须准确设置默认使用的对话框语言，以组态显示设备

的操作员文本和显示文本（通常为“英文”）。 这是确保在下次转换 OS 时不覆盖已翻

译消息的唯一方法。

● 编译 OS 时，将始终参考与 SIMATIC Manager 中的“显示单元的标准语言”(Standard 
language for display units) 具有相同语言设置的列。 
WinCC 项目管理器的文本库中的文本是由 PCS 7 自动输入的。仅当修改了单位和操作

员文本时，才需更改这些文本。

说明

如果重新编译 OS，则不能在 SIMATIC Manager 中切换“显示设备的默认语言”(Default 
language for display devices)。 在这种情况下，可覆盖已翻译的条目。

更多相关信息，请参见《过程控制系统 PCS 7；操作站》文档中的“编译 OS 与文本库

之间的关系”部分。

8.5.7 如何将其它库中的对象复制到主数据库

本部分介绍如何将 PCS 7 版本提供的库中的对象或外部供应商提供的其它库中的对象传送

到主数据库。     

说明

软件更新期间，仅将其版本已在要更新的项目中使用的对象从 PCS 7 V8.0 复制到新主数

据库。

说明

在 SIMATIC 站上，仅可加载一个 PCS 7 版本的 AS 块。
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更新项目中使用的库

根据所用块的不同，需要使用以下库中的块对其进行更新：

● PCS 7 基本库

● PCS 7 高级过程库 (APL)

● PCS 7 库（相关信息，请参见“如何安装附加 PCS 7 库 (页 62)”部分）

要求

● 在要更新的项目中创建了主数据库。

步骤

1. 在 SIMATIC Manager 中，选择菜单命令“文件”(File) >“打开”(Open)。

2. 打开“库”(Libraries) 选项卡。

3. 选择所需的库，然后单击“确定”(OK)。
将打开库。

4. 在打开的库（源）中选择要复制的库的部分。

5. 选择菜单命令“编辑”(Edit) >“复制”(Copy)（例如，过程标签类型、块）。

6. 选择主数据库（目标）中要用来存储已复制的库组成部分的文件夹。

7. 选择菜单命令“编辑 > 粘贴”(Edit > Paste)。
所复制的库组成部分将保存在主数据库中。

修改默认文本

必须在主数据库中修改默认文本，其中的块（在 PCS 7 V7.1 SP3 等中创建的块）已经被 
PCS 7 V8.1 块替换。

更多信息

● “编辑面板文本 (页 79)”部分

8.5.8 如何填充主数据库

仅当更新主数据库中未完全组态的项目时，才需要执行以下任务。  
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要求

● 已创建主数据库并已打开。

● SIMATIC 站的“离线”(Offline) 块文件夹已打开。

● 在 SIMATIC 站中仅使用 PCS 7 库的原始块。

● 在 SIMATIC 站中不使用不同 PCS 7 版本的块，并且在更新 PCS 7 后还要继续使用一

个 PCS 7 版本的块。

说明

在 SIMATIC 站上，仅可加载一个 PCS 7 版本的 AS 块。

步骤

1. 选择菜单命令“视图”(View) >“详细信息”(Details)。

2. 选择详细信息视图，然后单击列标题“作者”(Author)。 
这将按照“作者”(Author) 排列项目中使用的块和离线块文件夹中包含的块。

3. 在“作者”(Author) 列中选择所有列出的具有“旧”版本号的块（例如 DRIVER60、“...
60”、“...70”、...）。
按住 <Ctrl> 键可选择多个块。

说明

还需要为使用 BATCH 组态的项目选择以下 BATCH 块：

● 在“系列”(Family) 列中所有带有“BATCH”条目的块

● 块 READ_CLK 和 NOTIFY_8P（在使用它们时）

4. 选择在主数据库中不能提供的块或块区域。

5. 在快捷菜单中，选择菜单命令“复制”(Copy)。

6. 在打开的主数据库中，选择“块”(Blocks) 文件夹。

7. 在快捷菜单中，选择菜单命令“粘贴”(Paste)。 
如果已在“设置消息范围”(Set Message Range) 对话框中选中“始终提示设置”(Always 
prompt for settings) 复选框，复制块时将出现“选择消息号分配”(Message Number 
Assignment Selection) 对话框。

8. 选中“始终分配面向 CPU 唯一的消息号”(Always assign CPU-oriented unique message 
numbers) 复选框。

9. 选择下一个“离线”(Offline) 块文件夹，将该文件夹中的块与主数据库中已包含的块相比
较。 如果“离线”(Offline) 块文件夹中包含附加块，则将这些块复制到已创建的主数据库中。

10.对所有其它“离线”(Offline) 块文件夹重复步骤 5 至 9。
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8.5.9 显示归档值的趋势控件

在趋势控件中显示

要在趋势控件中显示归档值，只需考虑以下事项。

本部分与在趋势控件中显示在线变量无关。

可用归档的名称

如果正在更新的项目包含名为“过程值归档”(Process Value Archive) 的归档，则由系统生

成的归档变量将保存在名为“SystemArchive”的归档中。 

如果要通过趋势控件显示访问这些归档值，则必须在图形编辑器中更改块图标属性中的以

下设置：

● ReturnPath： 
为相应的过程变量传送趋势数据。

● StandardTrend： 
用于定义要在趋势视图中显示的趋势功能。

步骤

1. 在树形视图中，选择“样式”(Styles) 对象。

2. 进行以下设置：

– StandardTrend： 
将 2 更改为 3。

– ReturnPath： 
在返回路径中添加以下内容： *archivname:Systemarchiv*asia:
示例： U:CO_DKGREEN*archivname:SystemArchive*asia:

8.5.10 如何组态在线趋势控件的扩展

作为过程控制的一部分，可以在在线趋势控件中指定下列参数，以自动显示数值轴的各个

值：

● 限值

– 最大值（上限）

– 最小值（下限）

● 单元
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编译 OS 时，相关的功能块会自动采用用来在在线趋势图控件上显示变量的这些参数。

参数属性“S7_trend”

如果数据类型是以下类型之一，则可为功能块 I/O 分配参数属性“S7_trend”。

● INT

● DINT

● Real

要求  

● 对于需要考虑在线趋势控件中的限值（上限和下限）的块和相应的 I/O，参数属

性“S7_trend”设置为 TRUE。

● “在线趋势控件”对象已插入到过程画面中。

说明

对于“在线趋势控件”对象（属性、“数值轴”(Value axis) 选项卡、“范围选择”(Range 
selection) 组），“自动”(automatic) 复选框默认激活。

说明

在在线趋势控件中自动修改归档变量的上限和下限需要下列 CFC 组态：

在 CFC 中组态相关块时，请设置归档参数（即分配的参数 S7_trend）。

PCS 7 中不支持使用 WinCC 变量记录进行组态。

步骤

1. 在 SIMATIC Manager 中打开组件视图。

2. 在库（主数据库）中选择块（块类型）。

3. 选择菜单命令“编辑 > 打开对象”(Edit > Open Object)。
将打开“LAD/FBD/STL”对话框。

说明

如果显示一条消息，说明该块被写保护，只需将其忽略即可。

4. 在树形视图中，选择要为其指定参数的块 I/O。

5. 选择菜单命令“编辑”(Edit) >“对象属性”(Object Properties)。

6. 选择“属性”(Attributes) 选项卡。

7. 在一个空行中，从下拉列表框中选择“S7_trend”条目。
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8. 在“值”(Value) 列中，输入要用来为选定的 I/O 参数化上下限值的块 I/O 的名称。 用逗号分
隔这些名称（例如：LL_Name,HL_Name）。

9. 单击“确定”(OK)。

10.选择菜单命令“文件 > 保存”(File > Save)。
将打开“保存 ...”(Save ...) 对话框。

11.单击“是”(Yes)。

12.选择菜单命令“文件”(File) >“关闭”(Close)。

更多信息

● STEP 7 在线帮助

8.5.11 如何更新主数据库

简介

必须用最新 PCS 7 库中的块替换您创建的主数据库中的块。 

说明

PCS 7 库
自 PCS 7 V7.1 起，Process Control System; SIMATIC PCS 7 DVD 中包含的 PCS 7 块将

分配到不同的库。

冗余 I/O 模块的库

如果要在项目中使用冗余模块，还必须更新“冗余 IO (V1)”库。

要求

● 主数据库中包含要更新的项目的所有块。

● 已打开主数据库。

● 该库不包含任何 PCS 7 V4 或 V5 块（类型： IN_...、Out_ ... 和 PA_blocks，都低于块

版本 5.2）。
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规则

说明

在要更新的项目中替换这些块时，必须同步各个块的属性。 例如，如果已将“S7_m_c”属

性分配给附加输出，则仍可应用原有块的各个属性。 如果未对默认设置进行任何更改，则

可应用新块的属性。

有效性

说明

以下各部分中介绍的步骤，仅适用于对象名称或名称（标题）在库版本之间没有变化的块。

步骤

1. 在 SIMATIC Manager 中，选择菜单命令“文件”(File) >“打开”(Open)。

2. 打开“库”(Libraries) 选项卡。

3. 选择一个要从中导入块的库（例如 PCS 7 AP Library V80）。 单击“确定”(OK)。
将打开库。

4. 双击“块和模板”(Blocks+Templates) 文件夹，然后双击“块”(Blocks) 文件夹。

5. 按上下方向排列库，这样能够轻松地同时看到两个窗口中的内容，并且主数据库位于顶部。

6. 按住 <Ctrl> 键，从所选的库中选择同时存在于主数据库中的所有块。

7. 右键单击所选块或块区域，然后在快捷菜单中选择菜单命令“复制”(Copy)。

8. 在主数据库中选择“块”(Blocks) 文件夹，然后在快捷菜单中选择菜单命令“粘贴”(Paste)。

9. 单击“更新属性”(Update Attributes) 按钮可分别同步每个块的属性。
如果发现不同的属性，将通过一个对话框显示这些块属性之间的差异。

10.检查属性和特定项目的设置。

说明

建议应用默认设置。

说明

如果在“插入功能块”(Insert Function Block) 对话框中单击“全部”(All) 按钮，将在未同

步属性的情况下复制所有块。

11.单击“确定”(OK)。
如果未发现属性之间存在差异，则会显示一个对话框，对此加以说明。

12.单击“确定”(OK)。
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13.单击“是”(Yes)。
对应块复制到主数据库中，并且已将属性同步。

14.重复这些步骤以选择其它库。

说明

对于使用 BATCH 组态的项目，使用 SIMATIC BATCH BLOCKS 库重复执行此步骤。

8.5.12 如何在块导入中包含块类型的事件文本

简介

对于项目的软件更新，应注意的一个方面是通过复制块类型生成的块实例的消息文本没有

类型参考。 如果更新软件后添加了其它显示语言（如意大利语、西班牙语），这些显示语

言的消息文本将在块类型的块实例中以英语显示。     

导入和编辑块实例的消息文本

如果要针对整个 S7 程序自动覆盖块类型中所有块实例的消息文本，将需要进行以下设置。

如果要编辑实例的消息文本，将需要禁用此设置并再次执行导入。

步骤

1. 在 SIMATIC Manager 中打开组件视图。

2. 在库（主数据库块）中选择块（块类型）。

3. 选择菜单命令“编辑 > 特殊对象属性 > 消息号”(Edit > Special Object Properties > Message 
Numbers)。
将打开“PCS 7 消息组态”(PCS 7 Message Configuration) 对话框。

4. 在表格“事件”(Event) 列右侧的消息文本列中完成以下设置： 该符号显示如下：

– 激活要从块类型导入的消息文本的复选框。

– 禁用不想从块类型导入的消息文本的复选框。

说明

S7 程序中块类型的所有块实例的消息文本都将被覆盖！ 
如果要再次修改块类型的实例，必须清除相应的复选标记，然后执行另一次块导入。

5. 单击“确定”(OK)。
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8.5.13 如何导入操作员文本

要求

已从要更新的项目中导出用户文本。  

导入用户文本

1. 在 SIMATIC Manager 中打开要更新的项目。

2. 在组件视图中选择主数据库文件夹。 如果此文件夹不可用，则选择项目文件夹。

3. 选择菜单命令“选项 > 管理多语言文本 > 导入”(Options > Manage Multilingual Texts > 
Import)。
将打开“导入用户文本”(Import User Texts) 对话框。

4. 指定存储位置和导入文件的格式（可能的格式有： *.xls 和 *.csv）。

8.5.14 如何修改操作员文本

要求

● 主数据库包含 PCS 7 V8.1 块。

● 已打开主数据库。

● 已记下“S7_shortcut”、“S7_string_0”和“S7_string_1”参数属性及相应 PCS 7 块的文

本。

步骤

可采用不同的步骤修改操作员文本：   

● 修改块类型

更多相关信息，请参见手册《过程控制系统 PCS 7；操作员站》(Process Control System 
PCS 7; Operator Station) 中的“如何在块类型中编辑文本”部分。

●
更多相关信息，请参见手册《过程控制系统 PCS 7；操作员站》(Process Control System 
PCS 7; Operator Station) 中的“如何在块类型中编辑文本”部分。

建议修改块类型的操作员文本。 这样可确保：

● 可使不同自动化系统中相同块的操作员文本保持一致。

● 修改后的文本在以后组态中随时可用。

ES 上 PCS 7 项目的修改

8.5 更新块

使用新功能的软件更新

维修手册, 03/2015, A5E32786300-AB 89



如果已在手动模式下在 CFC  块实例中修改操作员文本，则必须在已修改的块实例中也修

改块类型。

更多信息

● 手册《过程控制系统 PCS 7；块编程指导》(Process Control System PCS 7; 
Programming Instructions for Blocks) 中的“用于操作员控制模拟和二进制值的 ES 文
本”(ES Texts for Operator Control of Analog and Binary Values) 部分

● 组态手册《过程控制系统 PCS 7；操作站》(Process Control System PCS 7; Operator 
Station) 中的“修改单位和操作员文本”(Adapting the Unit and Operating Texts) 部分。

8.5.15 如何更新项目中的块类型

说明

仅当同名块在多项目的所有项目中都具有相同结构和属性时，才能使用主数据库。   

要求

已使用当前块类型创建主数据库。

步骤

1. 在主数据库的块文件夹中选择所有要更新的块。

2. 选择菜单命令“选项 > 图表 > 更新块类型”(Options> Charts > Update Block Types)。
将打开“更新块类型”(Update Block Types) 对话框。

3. 为与主数据库中的块类型不同的所选块类型，选择要进行分析的 S7 程序。

4. 单击“下一步”(Next)。
将检查所有选定的 S7 程序，并会打开用于选择块类型的另一个对话框。 这将提供有关更新
块类型的可能结果的信息。

5. 指定要为各个 S7 程序更新的块类型。 必须选择所有要更新的块类型。可根据需要从更新中
排除所选块类型。 如果没有可用于更新的块类型，将不会显示块类型。 在此情况下，请关
闭对话框。

6. 单击“下一步”(Next)。
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整理块文件夹

更新了项目中的块类型之后，建议整理所有自动化系统中的块文件夹。 该操作可避免未使

用的块导致数据管理的不一致。 

1. 打开每个 AS 的 CFC 图表。

2. 在 CFC 编辑器中，选择“选项 > 块类型”(Options > Block types)。
将打开“块类型”(Block types) 对话框。

3. 单击“整理”(Clean Up)。
将打开“整理块文件夹中的块类型”(Clean up block types in the block folder) 对话框。

4. 从列表中选择不需要的块。

5. 单击“确定”(OK)。

结果

将在所有选定的 S7 程序中更新块类型并显示日志。

包含 SFC 的项目

注意，如果在项目中使用 SFC，您需要更新 SFC 块。 新的 SFC 运行系统将随 SFC 一同

提供。 完成转换后，相关的块将自动复制到那些分配的图表文件夹已完成转换的块文件夹

中。  

更新软件时，可在禁用了 SFC/实例的情况下编译更改和下载更改。 

说明

系统插入 AS 图表文件夹中的 SFC 系统块

如果系统将 SFC 系统块 FB 245、FB 246、FB 300、FC 240 到 FC 250 插入 AS 中，则

必须将这些 SFC 系统块从当前的 SFC 库手动复制到 AS 的“离线”(Offline) 块文件夹

中。 
● “SFC 库\块 + 模板\块”中的 SFC 系统块 FB 245 到 FB 300 和 FC 240 到 FC 250 是 PCS 

7 的预留块，不可以重命名。 这意味着在使用 PCS 7 的 SFC 组件前，必须重新命名项目中
名称完全相同的用户块。

● 然后，必须进行完整编译（即使可选择编译更改也如此），且允许下载更改。 
请参见“编译 CFC 图表 (页 93)”

请参见 SFC 自述文件。
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8.5.16 如何更新项目中的 SFC 块类型

说明

仅当同名块在多项目的所有项目中都具有相同结构和属性时，才能使用主数据库。   

列出使用“旧”版本块类型的组件

将块类型或 SFC 类型的新版本插入主数据库后，或在主数据库中自定义块类型后，可使

用“更新块类型”功能列出仍在使用已修改块类型老版本的所有组件。 也可选择整个多项

目中其修改过的块类型将进行更新的组件。

要求

● 已使用当前块类型创建主数据库。

步骤

1. 在主数据库的图表文件夹中，选择一个或多个 SFC 类型。

2. 选择菜单命令“选项 > 图表 > 更新块类型”(Options> Charts > Update Block Types)。
将打开“更新块类型”(Update Block Types) 对话框。

3. 选择要进行检查 S7 程序，以比较其与在主数据库中选择的块类型/SFC 类型是否存在差异。

4. 单击“下一步”(Next)。
将检查所有选定的 S7 程序，并会打开用于选择块/SFC 类型的另一个对话框。 该对话框还
会提供升级该块/SFC 类型的可能影响的相关信息。

5. 指定要为 S7 程序更新的块/SFC 类型。 如果已选择所有要更新的块/SFC 类型， 可根据需
要从更新中排除所选块类型。

6. 如果没有要更新的块/SFC 类型，将不会显示任何块/SFC 类型。 在此情况下，请关闭对话
框。

7. 单击“完成”(Finish)。

结果

将在所有选定的 S7 程序中更新块/SFC 类型并显示一个日志。

更多信息

● 手册《过程控制系统 PCS 7；工程组态系统》
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8.5.17 编译 CFC 图表期间的序列

编译 CFC 图表的驱动程序块

由于在图表文件夹中导入了新的块类型，所以需要编译所有 CFC 图表。 此过程将使用导

入的驱动程序块并优化程序。 

驱动程序块和主数据库之间的关系

说明

使用 PCS 7 库时，假定对相关库的引用由驱动程序生成器完成。

使用“生成模块驱动程序”(Generate module drivers) 选项编译时，可在“设置模块驱动程

序”(Settings Module Drivers) 项下选择附加库（例如，主数据库）。 这样，在项目中包含

的所有驱动程序块就一定包含在此库中。

F 图表/F 块

说明

如果项目中包含 F 图表/块，但不升级到新的 F 技术版本，则不得删除 F-@ 图表。 否则，

F 程序会收到不同的签名。 然后，F 系统因更改的签名必须按照国家/地区特定的准则再次

经过接收过程。

8.5.18 编译 CFC 图表

步骤

1. 执行 S7 程序完整的编译。  

更多信息

● 手册《过程控制系统 PCS 7；工程组态系统》
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8.6 修改 OS 相关设置

8.6.1 修改操作员站概述

步骤概述

步骤 操作 ES OS 服务

器

OS 客
户端

AS

35 同步 OS 基本画面、本地计算机操作和面板 
(页 95)

X    

37 更新画面对象 (页 98) X    

用户界面与设计

软件更新后，必须将过程模式的用户界面设计设置为如下设计：

WinCC 3D

在使用不低于 PCS 7 V8.0 版本创建的项目中将自动提供该设置。

其它设计不可用于 PCS 7。

必须检查或编辑现有项目的这一设置。 

● 确保在系统中对所有项目进行统一设计设置是很重要的。

● 更改 WinCC 设计的设置时，应检查用户对象的显示，必要时可自定义用户对象的显示。

8.6.2 同步 OS 基本画面、本地计算机操作和面板

必须将 OS 基本画面和本地计算机操作传送到您的项目中。 项目的面板可继续使用。

在 OS 项目编辑器中同步

使用 OS 项目编辑器执行此步骤，该编辑器包含在 WinCC 项目管理器中。

ES 上 PCS 7 项目的修改

8.6 修改 OS 相关设置

使用新功能的软件更新

94 维修手册, 03/2015, A5E32786300-AB



8.6.3 如何同步 OS 基本画面、本地计算机操作和面板

要求

● 已使用项目移植器更新 PCS 7 项目中包含的操作站。

● PCS 7 OS 已在 WinCC 项目管理器中打开。

步骤

1. 选择 OS 项目编辑器，然后在快捷菜单中选择菜单命令“打开”(Open)。

2. 在“常规”(General) 选项卡中，选中“完整组态”(Complete configuration) 复选框。

3. 单击“布局”(Layout) 选项卡。

4. 选择所需的布局和监视器组态。

5. 单击“基本数据”(Basic Data) 选项卡。 根据下面的“基本数据”表格进行所需的设置。

6. 更新软件后，仅在必须为某些用户激活“仅限查看”(For observation only) 授权级别的情况
下，才执行此步骤。
选择“消息显示”(Message Display) 选项卡。 
激活所需的消息过滤器（请参见下面的“消息过滤器”表格）。

说明

无需在其余选项卡上为软件更新进行设置。 可应用默认设置。

7. 单击“确定”(OK)。
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基本数据

对话框区域 说明 操作

左上角

窗口

此窗口中列出具有不同产品版本和项目版本

更改日期的所有基本画面。

启动 OS 项目编辑器时，在项目版本中，带

有选中复选框的每个基本画面均会被产品版

本中的画面所覆盖。

激活由红色“X”标识的所有基本画面的复选

框。

右上角

窗口

此窗口列出具有不同产品版本和项目版本更

改日期的所有本地计算机操作。

启动 OS 项目编辑器时，项目版本中带有选

中复选框的每个本地计算机操作均会被产品

版本中对应的本地计算机操作所覆盖。

激活由红色“X”标识的所有基本画面的复选

框。

左下方

窗口

此窗口中列出具有不同产品版本和项目版本

更改日期的所有面板。

● 如果要通过相关产品版本的面板替换项目

中的可用面板，则需选择相应的复选框。 
然后会应用产品提供的设置。

● 如果已自定义“高级过程库”项目特定面

板的彩色范围且不希望重置它们，请确保

未选中“更新高级过程库的调色板颜色”
(Update palette colors of Advanced 
Process Library) 复选框。 （默认设置）。

● 如果想恢复到默认设置，请选中复选框“更

新高级过程库的调色板颜色”(Update 
palette colors of Advanced Process 
Library)。

说明

PCS 7 V8.1 中的“动态向导”已因为 AS 级的结构类型进行了更改。 
请确保已激活“更新动态向导脚本”(Update Dynamic Wizard Scripts) 复选框。 
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消息过滤器

参数 含义

可确认消息单

独列表

消息窗口有两个消息列表。 

一个列表显示用户具有所有“操作员过程控制”(operator process controls) 访问权限的区域

中的所有消息。 用户可确认此列表中的消息。 

另一个列表显示用户具有“区域授权”(authorization for area)，但不具有“操作员过程控

制”(operator process controls) 访问权限的区域的所有消息。 用户不能确认此列表中的消

息。 

总览区中的消息行仅显示可使用“操作员过程控制”(operator process controls) 访问权限确

认的消息。

可在单独页面

上确认的消息

（可切换）

上述的两个消息页面均可供用户使用。 在只包含一个列表的消息页面上以及总览区域的消

息行中，仅显示用户对“操作员过程控制”(operator process controls) 具有访问权限的区域

中的消息。

更多信息

● 在线帮助 WinCC 信息系统 > 选项 > 过程控制选项 > OS 项目编辑器

● 在线帮助 OS 项目编辑器

8.6.4 更新画面对象

简介

更新画面对象时，将使用当前 PCS 7 版本的块图标替换先前 PCS 7 版本的块图标。 这样

才能使用 PCS 7 V8.1 的所有功能。     

规则

仅更新所选模板画面的块图标。 为此，必须根据组态时使用的模板，使用相应的模板画面

来更新画面对象。 

● 为 APL 块图标使用“@TemplateAPLV8.pdl”或“@PCS7TypicalsAPLV8.pdl”。

● "为 PCS 库的块图标使用“@Template.pdl”或“@@PCS7Typicals.pdl”。

建议对每个单独的模板画面执行一次更新。
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8.6.5 如何更新画面对象

简介

如果已手动将模板画面中的画面对象插入并互连到过程画面之中，则必须手动更新这些画

面对象。 

必须使用用于组态的相应模板画面来更新画面对象。 
建议： 依次使用库中用到的每一个模板画面执行更新。

要求

● 已使用项目移植器更新 PCS 7 项目中包含的操作站。

● 所有基本画面都用 OS 项目编辑器替换。

● PCS 7 OS 已在 WinCC  项目管理器中打开。

● 已参阅组态手册《过程控制系统 PCS 7；操作站》(Process Control System PCS 7; 
Operator Station) 中的“多个模板文件的使用规则”部分。

步骤

1. 在图形编辑器中，打开任何包含画面对象的 WinCC 画面。 选择画面对象。

2. 在动态向导中，打开“画面功能”(Picture Functions) 选项卡，然后选择“更新画面对象”
(Update Picture Objects)。
将打开“动态向导”(Dynamic Wizard) 对话框。

3. 单击“下一步”(Next)。

4. 选中“是，所有画面”(Yes, all pictures) 复选框。

5. 单击“下一步”(Next)。

6. 在列表中选择已使用 OS 的画面对象进行了组态的模板。 （默认值：@Template.pdl） 
@Template.pdl)

7. 从“请指定组态文件名称”(Please specify name of configuration file) 字段中，选择默认
的“TemplateControl.cfg”组态文件。

8. 单击“下一步”(Next)。

9. 单击“完成”(Finish)。
将在“动态向导”(Dynamic Wizard) 中启动画面对象生成。
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更多信息

有关如何修改画面对象的更多信息，请参见组态手册《过程控制系统 PCS 7；操作站》

(Process Control System PCS 7; Operator Station) 中的以下部分：

● “块图标和面板的功能及使用”部分

● “如何在扩展状态显示中插入自定义画面”部分

● “如何使用自定义画面组态块图标”部分

● “创建和实现用户对象”部分

8.7 Process Historian 的相关修改

8.7.1 Process Historian 的相关修改总览

步骤概述

步骤 操作 ES OS 服务

器

OS 客
户端

AS

37 更新 Process Historian 和 Information 
Server (页 99) 

X X   

38 将中央归档服务器替换为 Process Historian 
(页 100) 

X X X  

 

8.7.2 如何更新 Process Historian 和 Information Server

在 PCS 7 项目中如果存在以下 PC 站，则必须在执行软件更新前更新这些 PC 站：

● Process Historian
相关信息，请参见系统手册《SIMATIC HMI；Process Historian》(SIMATIC HMI; 
Process Historian)。

● Information Server
相关信息，请参见系统手册《SIMATIC HMI；SIMATIC Information Server》(SIMATIC 
HMI; SIMATIC Information Server)。
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8.7.3 如何将 CAS 替换为 PH

如果之前在 PCS 7 项目中使用中央归档服务器 (CAS)，则此服务器无法从自 V8.1 起的 
PCS 7 工厂归档新的工厂数据。 

建议：

请使用以下 PC 站代替 CAS：

● Process Historian，作为外部归档服务器

● Information Server，作为报告系统

要求

● 已安装 Process Historian。

● 根据具体工厂的指导原则组态 Process Historian（工作组/域中的新 PC 站 - 网络地址、

用户等）。

● 更新工程师站的软件。

● 更新 PCS 7 项目。

步骤

1. 在工程师站上打开 SIMATIC Manager。

2. 在组件视图中打开 PCS 7 项目。

3. 在 SIMATIC Manager 的组件视图中执行如下操作：

– 如果 CAS 站位于多项目中的独立项目：

选择 CAS 站的项目。

从快捷菜单中选择“多项目 - 从多项目中删除”(Multiproject - Remove from 
multiproject)。
CAS 站将从多项目中删除。

– 如果 CAS 站与其它站位于同一个项目中：

在 SIMATIC Manager 的组件视图中，选择“CAS”角色的 PC 站。

从快捷菜单中选择“删除”(Delete)。单击“是”(Yes)。 
CAS 站将从项目中删除。
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4. 对多项目中在 CAS（OS 服务器和单站系统）上存储了数据的所有 OS，执行下列任务：

– 打开 PC 站“属性”(Properties) 对话框中的“备份组态”(Backup Configuration) 选项

卡。

– 清除以下选项的“启用备份”(Backup enabled) 复选框：

-“变量记录 > 归档组态 > 快速变量记录”(Tag Logging > Archive configuration > Tag 
Logging Fast)
-“变量记录 > 归档组态 > 慢速变量记录”(Tag Logging > Archive configuration > Tag 
Logging Slow)
-“报警记录 > 归档组态 > 消息归档”(Alarm Logging > Archive configuration > Message 
archive)

– 如果要换出 SIMATIC BATCH 报表，需要禁用将报表导出到 CAS。 

说明

CAS 备份组态

如果项目中不存在 CAS 计算机，但输入了目标路径，则在每次备份文件段切换时会生

成过程控制错误。

5. 对多项目中具有 CAS 分配的所有操作站执行以下任务：

– 在 SIMATIC Manager 的组件视图中，选择 PC 站上的 OS 项目。

– 选择菜单命令“选项 > OS > 分配 OS 服务器...”(Options > OS > Assign OS Server...)。
将打开“分配 OS 服务器 ...”(Assign OS Server ...) 对话框。

– 在 OS 服务器的列表中，检查以下内容：

对于要在操作站上查看其数据的 OS 服务器，确保选中了相应的复选框。

– 清除 CAS 的 PC 站的复选框。

6. 在项目中为 Process Historian 创建一个新的 PC 站。

7. 为 Process Historian 组态新的 PC 站。
有关详细信息，请参见文档《过程控制系统 PCS 7；工程组态系统》(Process Control 
System PCS 7; Engineering System)。
保存并编译该组态。

8. 在 SIMATIC Manager 中设置属性。 为此，选择该 Process Historian 的 PC 站，然后选择
快捷菜单命令“对象属性”(Object properties)。 

9. 在“计算机名称”(Computer name) 组中输入计算机名称，或者激活“与 PC 站名称相同的
计算机名称”(Computer name identical to PC station name) 复选框。

10.单击“确定”(OK)。 
将关闭“属性”(Properties) 对话框。
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8.8 修改维护站

8.8.1 维护站更新概述

除了要完成为 OS 服务器指定的更新步骤外，还需要完成一系列附加步骤才能更新 MS 服
务器。 以下列出相应的附加步骤。

步骤概述

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

39 更改 OPC 服务器并修改 SNMP 组态 (页 102) X    

40 更新诊断设置 (页 104) X    

41 更新诊断画面 (页 105) X    

8.8.2 如何更改 OPC 服务器并修改 SNMP 组态

OPC 服务器版本

由于 OPC 服务器版本依赖所用的操作系统，因此在移植到不同操作系统后需要执行兼容

性检查。

如果不兼容，则请更换 OPC 服务器。

下表列出了兼容性。

MS 服务器的操作系统 OPC 服务器版本

Windows Server 2008 R2

Windows 7 Ultimate

V8.2

要求

● 项目的块、图表和 OS 画面已更新。

● 已编译 SIMATIC 程序和 OS。

● 维护站（MS 服务器和 MS 客户端）的 PC 站的更新方式与 OS 相同。
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● MS 多工作站系统

– 已在 MS 服务器的 PC 站上组态 OPC 服务器。

– 使用冗余 MS 服务器时，将组态下列站：

- MS 服务器 PC 站上的 OPC 服务器 
- 冗余伙伴 PC 站上的 OPC 服务器

● MS 单工作站系统

– 已在 MS 单工作站系统 PC 站上组态 OPC 服务器。

● 禁用设备状态监视功能

如果在项目中使用维护站，必须禁用设备状态监视功能。

步骤

1. 在组件视图中选择 PC 站。

– 在 MS 多工作站系统中，选择 MS 服务器或冗余伙伴的 PC 站。

– 在 MS 单工作站系统中，选择 MS 单工作站系统的 PC 站。

2. 在详细视图中双击“组态”(Configuration) 对象打开 HW Config。
将打开 SIMATIC PC 站的硬件配置。
如果无法看到硬件目录，则选择“视图 > 目录”(View > Catalog) 菜单命令。
将打开硬件目录。

3. 从“SIMATIC PC 站 > 用户应用程序 > OPC 服务器”(SIMATIC PC-Station > User application 
> OPC Server) 硬件目录中选择最新版本的 OPC 服务器，并将其拖放到 OPC 服务器的位
置。

4. 单击“确定”(OK) 确认替换 OPC 服务器。

5. 保存并编译更改。

6. 在机架中选择“OPC 服务器”(OPC Server) 对象。

7. 选择菜单命令“站”(Station) >“属性”(Properties)。

8. 打开“SNMP”选项卡。

9. 单击“导出用于 WinCC 的变量”(Export Tags for WinCC) 按钮。

10.选择菜单命令“站”(Station) >“保存并编译”(Save and Compile)。

11.如果在冗余 MS 多工作站系统中使用了 MS 服务器，则重复步骤 1 至 5。

12.如果项目中包含用 SIMATIC PDM 组态的现场设备，请执行以下操作：

– 在 SIMATIC Manager 中选择“选项 > SIMATIC PDM > 设置”(Options > SIMATIC 
PDM > Settings) 命令。

将打开“SIMATIC PDM 设置”(SIMATIC PDM Settings) 对话框。

– 选择“维护工作站”(Maintenance Station) 选项卡。

– 输入 PCS 7 项目的文件路径。

– 单击“确定”(OK)。
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更新 SIMATIC PDM

通过 Process Control System; SIMATIC PCS 7 DVD 安装 SIMATIC PDM，请参见 PDM 
自述文件。

在 SIMATIC Manager 中打开项目后，将自动更新 SIMATIC PDM 相关的项目数据。 

说明

更新期间，新的 PLT ID 将分配给已组态的 ASSETMON 对象。 之后请执行以下步骤：

● 将这些 PLT ID 修改为对应的 ASSETMON 块实例。

● 编译自动化系统。

● 再次创建诊断画面。

● 编译相应的操作站。

说明

在工程师站上显示 PDM 数据的要求 
请注意，需要在工程师站的 SIMATIC PDM ASSET Service Manager 中手动启动一次 
SIMATIC PDM ASSET 服务。 SIMATIC PDM ASSET Service Manager 位于操作系统工

具栏的信息区。

更多信息

● 有关组态用户诊断结构和用户诊断画面的信息，请参见《过程控制系统 PCS 7；操作

站》(Process Control System PCS 7; Operator Station) 组态手册。

● 有关在过程模式下使用维护站的说明，请参见手册《过程控制系统 PCS 7；操作站过程

控制》(Process Control System PCS 7; Operator Station Process Control)。

8.8.3 如何更新诊断设置

简介

如果在项目中运行 PCS 7 维护站，当升级到当前 PCS 7 版本时，必须移植多个设置。
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要求

OS 项目编辑器正在运行。 不必在 OS 项目编辑器中进行任何设置。

说明

如果检索到项目

如果检索到与软件更新相关的项目，若是使用维护站，还将需要执行如下附加步骤：

1. 编译所有自动化系统的硬件配置。

2. 使用选项“更新模块驱动程序”(Update module drivers) 编译所有自动化系统。 

步骤

1. 在工厂层级中选择多重项目。  

2. 选择“选项”(Options) >“工厂层级”(Plant Hierarchy) >“设置...”(Settings...) 菜单命令。
将打开“自定义工厂层级”(Customize Plant Hierarchy) 对话框。

3. 选中“移植诊断设置”(Migrate diagnostic settings) 复选框。

说明

如果不需要此操作，此区域将以灰色显示。

4. 单击“确定”(OK)。

说明

如果要恢复项目特定的更改，则必须对自动创建的总览画面进行调整。 执行“移植诊断

设置”(Migrate diagnostic settings) 功能后，将要更新项目的重命名总览画面中项目特定

的更改复制到当前总览画面。

8.8.4 如何更新诊断画面

更新诊断画面会产生以下影响：

● AS 对象区域中的画面

将在画面中重新定位表示机架的块图标。

可以将块图标移动到其它位置。

● PC 站和网络对象区域中的画面

这些画面中的块图标可能会发生重叠。

可以将块图标移动到其它位置。
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要求

● 已生成带有项目具体修改内容的诊断画面的备份副本。

● 已在 HW Config 中将资产 ID 分配给各个 AS 和 PC 站。

● 已更新诊断设置。

步骤

1. 在工厂层级中选择多重项目（项目）。

2. 选择“选项”(Options) >“工厂层级”(Plant Hierarchy) >“创建/更新诊断画面”(Create/Update 
Diagnostics Screens) 菜单命令。 
更新诊断画面。相关信息，请参见组态手册《过程控制系统 PCS 7；操作站》(Process 
Control System PCS 7; Operator Station)。

说明

自动为容错自动化系统新建 AS 详细视图的诊断画面。

● 先前的诊断画面将追加扩展名并保存到 WinCC 项目管理器的“图形”(Graphics) 文件夹
中。

● 如果要恢复项目特定的更改，则必须对自动创建的诊断画面进行调整。 执行“创建/更新
诊断画面”(Create/update diagnostics screens) 功能后，将上一诊断画面中项目特定的更
改复制到当前诊断画面。

3. 编译维护站的 OS。

4. 更新 MS 服务器的服务器数据。

5. 下载 MS 服务器。

更多信息

有关用于访问维护功能的选项的信息，请参阅以下文档：

● 有关在过程模式下使用维护站的说明，请参见功能手册《过程控制系统 PCS 7；操作站

过程控制》(Process Control System PCS 7; Operator Station Process Control)。

● 组态手册《过程控制系统 PCS 7；操作站》(Process Control System PCS 7; Operator 
Station)

● 功能手册《过程控制系统 PCS 7；维护站》(Process Control System PCS 7; 
Maintenance Station)
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8.9 附加选项

8.9.1 附加选项概述

步骤概述

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

42 更新 PCS 7 OS Web 选件 (页 107) X X   

43 更新使用 SIMATIC Logon 服务的 PCS 7 组件 
(页 108) 

X X X  

 

8.9.2 更新 PCS 7 OS Web 选件

要求

为了使用 PCS 7 OS Web 选件的全部功能，您只能在 PCS 7 项目中使用最新 PCS 7 库中

的块。       

步骤

● 更新 OS 客户端和 OS Web 服务器（其更新方式与更新 OS 客户端相同）。

● 必须再次“发布”将要在 Web 客户端上打开的过程画面。

更多信息

更多相关信息，请参见手册《过程控制系统 PCS 7；OS Web 选项》。 
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8.9.3 更新使用 SIMATIC Logon 服务的 PCS 7 组件

更多信息 

● 有关 SIMATIC Logon 所需的安装、参数分配和更改的具体说明，请参见使用 SIMATIC 
Logon 的各个组件。

● SIMATIC Logon 在线帮助提供了 SIMATIC Logon 的常用基本信息。

8.10 在 SIMATIC 管理器中使用 OS

8.10.1 编译概述

步骤概述     

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

44 指定编译模式 (页 109) X    

45 编译 OS (页 110) X    

46 调整 OS 客户端 (页 112) X    

8.10.2 编译模式相关信息

通过编译模式可确定哪些数据下载到 OS 服务器。 必须为多项目中的每个项目单独进行设

置。    
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编译模式

可使用以下模式：

模式 含义

面向区域 从 PCS 7 V6.1 起： 新建项目的默认设置

利用此设置可将 PH 的 OS 区域分配给 OS 服务器。 

使用此编译模式时，OS 区域的所有数据都将下载到 OS 服务器。

只能为已组态 PH 的项目设置此模式。

面向 AS 利用此设置可将 S7 程序分配给 OS 服务器，即，定义要访问自动化

系统中的数据的对应 OS。 使用此编译模式时，自动化系统的所有数

据都将下载到 OS 服务器。 默认为以下项目设置此模式：

● 在早于 V6.1 的 PCS 7 版本中创建的项目。

● 未组态 PH 的项目。

 

说明

如果在项目中使用维护站，则需要为多项目设置“面向区域”(area-oriented) 编译模式。

更多信息

● 组态手册《过程控制系统 PCS 7；操作站》(Process Control System PCS 7; Operator 
Station)

8.10.3 如何指定编译模式

要求

● 已使用项目移植器更新 PCS 7 项目中的操作站（如有必要）。   

步骤

说明

更改编译模式后，只能在执行 OS 的完整下载后才能执行在线下载。
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1. 打开 SIMATIC Manager 并选择任意视图。 组件视图、工厂视图或过程对象视图。

2. 在树形结构中选择一个 PCS 7 项目。

3. 选择菜单命令“选项”(Options) >“编译多个 OS”(Compile Multiple OSs) 向导 >“编译模式”
(Compilation Mode)。
将打开“编译模式”(Compilation Mode) 对话框。

4. 选择编译模式（请参考上述关于此部分的介绍）。

5. 单击“确定”(OK)。

将在“编译多个 OS”(Compile Multiple Oss) 向导中应用编译模式的设置。

说明

首次通过 PCS7 V8.1 编译 OS 时，需要通过存储器复位进行完整编译。 系统会对此进行

检测并自动进行设置。 无法更改编译模式。 

说明

这些设置适用于一个项目中的所有 OS 服务器。

更多信息

● 组态手册《过程控制系统 PCS 7；操作员站》(Process Control System PCS 7; Operator 
Station)

8.10.4 如何编译 OS

说明

如果在 ES 上更改了目标路径，则必须编译 OS。   
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说明

使用 V7 或 V8 块图标的模板画面

如果满足以下前提条件，则可使用“@PCS7TypicalsAPLV7.pdl”模板画面：

● 不希望使用 PCS 7 V8.1 的新功能

● 由于图标大小发生更改等原因，您不希望使用“@PCS7TypicalsAPLV8.pdl”模板画面的最
新图标来更新画面对象。

需要重命名“@PCS7TypicalsAPLV8.pdl”文件或者删除此文件，以便可以使用“创建/更新

块图标”功能以及在随后执行过程中使用此“@PCS7TypicalsAPLV7.pdl”模板画面的编译

过程。重命名的文件不得以下列字符开头：

● @PCS7Typicals
● @TemplateAPL
建议：

对于 PCS 7 项目，始终使用相同版本的“@TemplateAPL<Version>.pdl”
和“@PCS7TypicalsAPL<Version>.pdl”文件。

覆盖默认设置

画面对象的用户脚本和已修改属性由默认设置所覆盖。

要求

● 已组态 PC 站。

● 已完成 CFC 和 SFC 中的组态。

说明

如果已在主数据库中更改了块类型的单位和操作员文本，应确保将默认语言设置为“显

示设备的语言”(Language for display devices)。

步骤

说明

有关编译选项的更多信息，请参见组态手册《过程控制系统 PCS 7；工程组态系统》。

1. 在 SIMATIC Manager 中，选择要编译或要编译/下载的对象（多项目、项目、站）。

2. 在 SIMATIC Manager 中选择 “PLC > 编译和下载对象”(PLC > Compile and download 
objects) 命令。
将打开“编译和下载对象”(Compile and download objects) 对话框。

3. 打开树形结构。
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4. 对于所有要编译的对象，激活“编译”(Compile) 列中的复选框。

5. 单击“操作状态”(Operating State) 按钮并检查对象的操作状态（RUN、已激活等），以便
为编译做出正确的设置。

6. 选择要编译的 OS。

7. 单击“编辑”(Edit)。
将打开“设置：编译 OS ... 区域 ...”(Settings: Compile OS ... Areas ...) 对话框。

8. 单击“编辑”(Edit)。
将打开“设置：编译 OS ... 网络连接 ...”(Settings: Compile OS ... Network Connections ...) 
对话框。

9. 单击“编辑”(Edit)。
将打开“设置：编译 OS ... 编译数据和编译范围”(Settings: Compile OS ... Compilation Data 
and Scope of Compilation) 对话框。

10.在“范围”(Scope) 组中，激活“整个 OS”(Entire OS) 和“将存储器复位”(With memory 
reset) 复选框。

11.单击“应用”(Apply)。

说明

完成操作站的编译设置后，请等待直到保存编译设置并显示下载对话框。 

12.对各个对象进行所需设置。

13.单击对话框中的“帮助”(Help) 可查看有关设置的详细信息。

14.单击“启动”(Start) 按钮。 
编译开始。

15.按画面上的说明操作。

16.如果希望在编译完成后立即查看编译日志，可在“显示日志”(Display Log) 区域中单击以下
按钮：

– “单个对象”(Single object)： 将显示所选 OS 的详细编译日志。

– “全部”(All)： 将显示所有编译的结果（无详细信息）。

8.10.5 如何对 OS 客户机进行修改

说明

如果项目中有多个 OS 服务器，则必须为每个 OS 服务器执行以下步骤。   
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步骤

1. 在 SIMATIC Manager 的组件视图中，选择 PC 站上的 OS 客户端项目。

2. 选择菜单命令“选项 > OS > 分配 OS 服务器...”(Options > OS > Assign OS Server...)。
将打开“分配 OS 服务器 ...”(Assign OS Server ...) 对话框。

3. 在 OS 服务器（要将其数据显示在该客户端上）的列表中，检查这些 OS 服务器的复选框是
否已选中。

4. 单击“确定”(OK)。

5. 打开 OS 客户端的 OS 项目。
WinCC 项目管理器将打开。

6. 如果有冗余 OS 服务器，可在“服务器数据”(Server data) 编辑器的快捷菜单中选择菜单命
令“组态”(Configure)，以指定首选服务器。

7. 在“服务器数据”(Server data) 编辑器的快捷菜单中，选择菜单命令“标准服务器”(standard 
server)，以便为中断和 SSM 指定标准服务器。

8. 选择 OS 项目编辑器，然后在快捷菜单中选择菜单命令“打开”(Open)。

9. 在“常规”(General) 选项卡中，激活“全部组态 ...”(Complete configuration ...) 复选框。

10.单击“布局”(Layout) 选项卡。

11.选择所需的布局和监视器组态。

12.单击“基本数据”(Basic Data) 选项卡。 根据下面的“基本数据”表格进行所需的设置。

13.更新软件后，仅在必须为某些用户激活“仅限查看”(For observation only) 授权级别的情况
下，才执行此步骤：

14.选择“消息显示”(Message display) 选项卡。 
激活所需的消息过滤器（请参见下面的“消息过滤器”表格）。

说明

无需在其余选项卡上为软件更新进行设置。 可应用默认设置。

15.单击“确定”(OK)。

16.在 WinCC 项目管理器中，打开“时间同步”(Time Synchronization) 编辑器。
激活“通过终端总线同步（从站）”(Synchronization via terminal bus (slave)) 复选框。 
选择“使用所连 WinCC 服务器的时间”(Use the time from a connected WinCC server) 选项。 
关闭对话框。

17.打开“设备状态监视”(Lifebeat Monitoring) 编辑器，然后在对话框中单击“更新”(Update) 
按钮。 关闭对话框。
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基本数据

对话框区域 说明 操作

左上角

窗口

此窗口中列出具有不同产品版本和项目版本

更改日期的所有基本画面。

启动 OS 项目编辑器时，在项目版本中，带

有选中复选框的每个基本画面均会被产品版

本中的画面所覆盖。

激活由红色“X”标识的所有基本画面的复选框。

右上角

窗口

此窗口列出具有不同产品版本和项目版本更

改日期的所有本地计算机操作。

启动 OS 项目编辑器时，项目版本中带有选

中复选框的每个本地计算机操作均会被产品

版本中对应的本地计算机操作所覆盖。

激活由红色“X”标识的所有基本画面的复选框。

左下方

窗口

此窗口中列出具有不同产品版本和项目版本

更改日期的所有面板。

● 如果要通过相关产品版本的面板替换项目中

的可用面板，则需选择相应的复选框。 然
后会应用产品提供的设置。

● 如果已自定义“高级过程库”项目特定面板

的彩色范围且不希望重置它们，请确保未选

中“更新高级过程库的调色板颜色”(Update 
palette colors of Advanced Process 
Library) 复选框。 （默认设置）。

● 如果想恢复到默认设置，请选中复选框“更

新高级过程库的调色板颜色”(Update palette 
colors of Advanced Process Library)。

说明

PCS 7 V8.1 中的“动态向导”已因为 AS 级的结构类型进行了更改。 
请确保已选中“更新动态向导脚本”(Update Dynamic Wizard Scripts) 复选框。 
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消息过滤器

参数 含义

可确认消息单

独列表

消息窗口有两个消息列表。 

一个列表显示用户具有所有“操作员过程控制”(operator process controls) 访问权限的区域

中的所有消息。 用户可确认此列表中的消息。 

另一个列表显示用户具有“区域授权”(authorization for area)，但不具有“操作员过程控

制”(operator process controls) 访问权限的区域的所有消息。 用户不能确认此列表中的消

息。 

总览区中的消息行仅显示可使用“操作员过程控制”(operator process controls) 访问权限确

认的消息。

可在单独页面

上确认的消息

（可切换）

上述的两个消息页面均可供用户使用。 在只包含一个列表的消息页面上以及总览区域的消

息行中，仅显示用户对“操作员过程控制”(operator process controls) 具有访问权限的区域

中的消息。

8.10.6 不同版本 PCS 7 面板的混合操作

混合操作的定义

借助混合操作可查看不同 PCS 7 版本的 AS 块。

PCS 7 面板的兼容性

可将 PCS 7 V8.1 面板用于监控下列 PCS 7 版本的 AS 块：

● PCS 7 V7.1 SP3;PCS 7 V7.1 SP4

● PCS 7 V8.0 SPx

● PCS 7 V8.1

高级过程库 (APL) 面板的兼容性

从 PCS 7 V8.1 开始，OS 过程画面中就可以显示不同库版本 AS 块的块图标。 如果一个 
OS 分配给了多个 AS，则只可以为每个 AS 组态以下高级过程库版本的 AS 块：

● 来自 PCS 7 V7.1 SP3 的 AS 块

● 自 PCS 7 V8.1 起的 AS 块
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块图标会在 OS 编译完之后插入到过程画面中。 标准画面“@PCS7TypicalsAPLV8.pld”用

作创建/更新过程画面中所有 AS 块图标的模板。 
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使用 APL 9
9.1 切换至最新版本的 APL

切换 APL 的相关措施

转换为 APL 块需要重新执行应用特定的组态。 本章介绍了将 PCS 7 项目移植到最新 APL 
时需要采取的具体措施。

说明

如果要使用最新版本 APL 中的块，则在整个项目中只能使用该版本的块。

说明

安装最新的 APL 不会覆盖原有库。

9.2 修改概述

替换块

将 APL V7.1 更新到最新版本 APL 时，替换以下块：

● 通道块（例如 CH_CNTx）

● 电机启动器

● 高精度时间戳功能的块

相关操作

● APL V7.1 块必须替换为最新 APL 版本的块。

● 对标准库移植到 APL 的所有块，相应修改其组态数据。

说明

执行操作系统更新无法将所有模块调整为满足新 APL 版本的新要求。 某些情况下需要

更换硬件。
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要求

已安装 APL V8.1。

步骤

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

47 创建项目库 (页 118) X    

48 将块复制到项目库 (页 119) X    

49 创建引用列表  (页 120) X    

50 更新 APL 块 (页 121) X    

51 更新 S7 程序中的块 (页 122) X    

52 互连块 I/O (页 122) X    

说明

在调试之前执行测试

强烈建议您在对预组态图表进行测试后再开始调试。

9.3 如何创建项目库

可选任务

如果您已在 V7.x 项目中创建了项目库，则不必要完成此任务。 可以使用此项目库的副本

完成本章中的其它步骤。 如果尚未完成该任务，建议在此时创建项目特定的库。PCS 7 项
目中的待替换块会复制到该库。

要求

● 已使用项目移植器更新 PCS 7 项目中的操作员站

● PCS 7 项目已打开（在 ES 上）。
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步骤

1. 选择“文件 > 新建”(File > New) 打开“新建”(New) 对话框。

2. 选择“库”(Libraries) 选项卡并设置类型： “库”(Library)。

3. 在“名称”(Name) 输入字段中输入新库的名称（例如 NAME:"NEW_BIB"）

4. 单击“确定”(OK) 确认并保存输入的内容

5. 在下一对话框中选择该文件夹

6. 右键单击并选择“插入新对象 > S7 程序”(Insert new object > S7 program)，以插入 S7 程
序

7. 为新的项目特定库 S7 程序\块选择块文件夹

8. 将项目中已使用或要使用的同名块从最新版本的 APL 复制到新的项目特定库中。

9.4 如何将块复制到项目库

收集项目库中使用的块

如果项目库在软件更新之前已在项目中可用，则不需要执行此步骤。 可以使用此项目库的

副本完成本章中的其它步骤。

将 PCS 7 项目的 V7.1 块从“离线”(Offline) 文件夹复制到新的项目库中。

这样做是为了将所有自动化系统中的全部块都复制到项目库中。 

首先将“离线”(Offline) 块文件夹中第一个 AS 的所有 V7.x 块复制到主数据库中。 然后，

将库中的块与下一个 AS 的“离线”(Offline) 块文件夹进行比较。 将找到的任何其它块复制

到项目库中。 对所有自动化系统完成此任务。

要求

● 项目库已打开

● 块文件夹已打开，并且处于离线状态。

步骤

1. 选择“视图 > 详细信息”(View > Details)，打开详细视图，然后单击“作者”(Author) 列标
题。 如此将按照“作者”(Author) 列排列项目中使用的 V7.1 块和离线块文件夹中包含的 V7.1 
块。

2. 按下“CTRL”键并左键单击选择“作者”(Author) 列中列出的所有 APL V7.1 块。

3. 右键单击所选块或块区域，然后在快捷菜单中选择“复制”(Copy) 命令。
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4. 在打开的项目库中选择并右键单击“块”(Blocks) 文件夹。
在快捷菜单中选择“插入”(Insert)。 
 如果已在“设置消息范围”(Set Message Range) 对话框中选中“始终提示设置”(Always 
prompt for settings)，复制块时将出现“选择消息号分配”(Message Number Assignment 
Selection) 对话框。 选中“始终分配面向 CPU 唯一的消息号”(Always assign CPU-oriented 
unique message numbers) 复选框。

5. 选择下一个离线块文件夹，将其中的块与项目库中的块进行比较。
将找到的任何附加块从离线块文件夹复制到新的项目库中。

6. 对所有其它离线块文件夹重复步骤 5。

9.5 如何创建引用列表

创建引用列表

替换驱动程序块时，可以使用所有块的引用列表。

步骤

要创建此引用列表（块类型），请完成以下操作：

1. CFC： 打开 AS 的任一图表。

2. CFC： 选择“选项 > 图表引用数据”(Options > Chart Reference Data) 菜单命令，打开图
表引用数据的视图。 

3. 图表引用： 运行“视图 > 交叉引用”(View > Cross-References) 菜单命令。

现在生成的列表会包含所有块。

● 选择“图表引用数据 > 生成导出文件”(Chart Reference Data > Generate Export 
File)，将列表保存到文件中。 建议在 MS EXCEL 等工具中检查此列表。 此列表应只包

含对通道块和驱动程序块的引用，还应包含对高精度时间戳功能的块的引用。

● 选择“图表引用数据 > 打印”(Chart Reference Data > Print)，获取打印出的列表副本。

使用 APL
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9.6 如何更新 APL 块

替换块

必须用最新 APL 版本的块替换复制到新项目库中的 APL 块。

说明

在替换 APL 块时，需要同步各个块的属性。 如果未对默认设置进行任何更改，则可应用

新块的属性。

要求

● 自 PCS 7 V7.1 起，PCS 7 的 APL 块位于项目库中。

● 项目库已打开

步骤

1. 在 SIMATIC Manager 的“库”(Libraries) 选项卡中，选择菜单命令“文件 > 打开”(File > 
Open) 以打开“PCS 7 AP Library V81”。

2. 双击“块和模板”(Blocks+Templates) 文件夹，然后双击“块”(Blocks) 文件夹。

3. 垂直平铺排列这两个库窗口，以便更加清晰地查看其内容。 库窗口应位于顶部。

4. 按住“CTRL”键并单击鼠标，选择来自新版本 APL 并包含在项目库中的所有块。

5. 右键单击所选块或块区域，然后在快捷菜单中选择“复制”(Copy) 命令。

6. 在项目库中选择并右键单击“块”(Blocks) 文件夹。 在快捷菜单中选择“插入”(Insert)。

7. 单击“同步属性”(Synchronize Attributes)，分别为每个块同步属性。

8. 对话框会显示找到的任何属性差异。 检查属性和特定项目的设置。

说明

建议接受提供的默认设置。 
单击“确定”(OK)，将相应块（包括已同步属性）复制到项目库中。

如果未找到不同属性，则对话框会进行相应提示。 单击“确定”(OK) 确认此对话框。 
单击“是”(Yes)，将相应块（包括已同步属性）复制到项目库中。

单击“插入函数块”(Insert Function Block) 对话框中的“全部”(All) 按钮复制全部块，但

不同步其属性。

9. 将来自最新 APL 版本中与其余未替换的块对应的块复制到项目库并删除原有块。

使用 APL
9.6 如何更新 APL 块
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更多注意事项

● 有关最新 APL 版本的块的更多信息，请参见文档 PCS 7 库： 文件 LIB-Readme.wri

9.7 如何更新 S7 程序中的块类型和 SFC 类型

更新 S7 程序中的块

可以更新 S7 程序中的所有块。

要求

用最新 APL 版本的块替换了主数据库中的 APL 块并完成属性同步。

步骤

1. 在主数据库的块文件夹中选择所有块。

2. 选择菜单命令“选项 > 图表 > 更新块类型...”(Options > Charts > Update Block Types...)。 
将打开“更新块类型”(Update Block Types) 对话框。

3. 选择要进行检查，以比较其与在主数据库中选择的块类型/SFC 类型的差异的 S7 程序和任
意现有示例解决方案。

4. 单击“继续”(Continue)。
将检查所有选定的 S7 程序，并会打开用于选择块/SFC 类型的另一个对话框。 此处可获得
有关更新块/SFC 类型的可能结果的信息。

5. 指定要为各个 S7 程序更新的块类型/SFC 类型： 将选择所有要更新的块/SFC 类型。 必要
时，可取消选择全部不需要更新的类型。
如果不存在要更新的块/SFC 类型，将不会显示块/SFC 类型。 在此情况下，请关闭对话框。

6. 单击“完成”(Finish)。

9.8 如何创建块 I/O 的新互连

插入和重新连接块

如果要用最新 APL 版本的块替换其它库（非 APL）的块，则需完成此任务。 必须为要替

换的每个块的所有连接（块类型引用列表）完成以下操作。

有关块 I/O 的比较，请参见““Pcs7Cntx”块的块 I/O 总览 (页 137)”部分。

使用 APL
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要求

● 引用列表已打开。

● 图表文件夹包含最新 APL 版本的块。

● CPU 处于“离线”状态。

步骤

1. 打开图表

2. 将新块复制到图表

3. 将互连从原有块（例如 CH_CNT1 - 输入 LADDR）拖动到新块（例如 Pcs7Cnt2 - 输入 
Laddr）。

4. 对要替换的所有其它块重复第 1 步到第 3 步。

说明

在调试之前执行测试

强烈建议您在对预组态图表进行测试后再开始调试。

使用 APL
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使用新功能的软件更新

维修手册, 03/2015, A5E32786300-AB 123



使用 APL
9.8 如何创建块 I/O 的新互连

使用新功能的软件更新

124 维修手册, 03/2015, A5E32786300-AB



下载目标系统 10
在离线模式下更新了 PCS 7 项目后，需要将更改下载到目标系统（AS、OS）上。   

说明

如果使用 PCS 7 库中的新块或更新块，请在下载到目标系统之前将 AS 设置为 STOP。

要求

● 已组态 PC 站的网络地址和网络设置。

● HW Config 中的 PC 站组态与站组态编辑器中的 PC 站组态一致。

● 已组态 PC 站。

● 已通过 NetPro 下载所有站的组态和连接数据。

步骤

1. 检查每个 PC 站上的接入点设置（本地）。
在 Windows“开始”(Start) 菜单的 SIMATIC > SIMATIC NET 子菜单中，选择菜单命令“组态
工作台”(Configuration Console)。

2. 可以有计划地自动连续下载所有目标系统。 在 SIMATIC Manager 中，选择菜单命令 PLC 
>“编译和下载对象”(Compile and Download Objects)。

更多信息

更多信息，请参见手册《过程控制系统 PCS 7；工程组态系统》。
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下载目标系统
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激活操作员站 11
11.1 激活操作员站概述

简介

激活过程模式的顺序（运行时）： 

● Process Historian（如果存在于项目中）

● 主服务器（OS 服务器）

● 备用服务器（冗余 OS 服务器）

● OS 客户端

步骤概述

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

54 检查 OS 服务器的设置 (页 127)  X   

55 检查 OS 客户端的设置 (页 128)   X  

11.2 如何检查 OS 服务器上的设置

激活下载到不同 OS 服务器的项目之前，安全起见，需要对每个 OS 中的一些设置进行检

查。   

要求

● PCS 7 OS 已在 WinCC 项目管理器中打开。

● 如果项目中存在 Process Historian，则以下要求适用：

– Process Historian 处于“激活”状态。

– 对每个 OS 服务器执行了“PH-Ready 组态”。

使用新功能的软件更新
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步骤

1. 在 WinCC 项目管理器中打开“冗余”(Redundancy) 编辑器。

2. 检查所有设置。

3. 单击“确定”(OK)。

4. 在 WinCC 项目管理器中打开“时间同步”(Time Synchronization) 编辑器。

5. 检查对话框中的所有设置。

6. 单击“确定”(OK)。

7. 对第二个 OS 服务器和所有其它冗余 OS 服务器重复步骤 1 到 6。

说明

如果已安装新的操作系统，或已更改设置，请重新启动计算机。

8. 在 OS 服务器上激活过程模式。

说明

Process Historian
激活过程模式后，OS 服务器会自动连接到 Process Historian， 
● 对于非冗余系统，数据将在过程模式激活后发送至 Process Historian。 
● 对于冗余系统，仅将来自当前主站的数据发送至 Process Historian。
现在，可以使用“过程数据移植器”将软件更新前创建的数据段导入 Process Historian。
相关信息，请参见“如何将归档移植到 Process Historian 中 (页 135)”部分。

11.3 如何检查 OS 客户机上的设置

简介

在激活下载到不同 OS 客户端上的项目之前，必须对每个 OS 中的一些设置进行检查。   

要求

● PCS 7 OS 已在 WinCC 项目管理器中打开。

步骤

1. 在 WinCC 项目管理器中打开“时间同步”(Time Synchronization) 编辑器。

2. 检查所有设置。

3. 单击“确定”(OK)。

激活操作员站
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4. 对其它 OS 客户端重复步骤 1 到 3。

5. 在 OS 客户端上激活过程模式。

激活操作员站
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激活操作员站

11.3 如何检查 OS 客户机上的设置
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更新 SIMATIC BATCH 工作站 12
简介

说明

将软件从 PCS 7 V7.1 SP3（含 SIMATIC BATCH）更新为 PCS 7 V8.1（含 SIMATIC 
BATCH）时，请遵循以下几点：

● 要保存项目并重组，首先需要在 HW Config 中手动更换 PC 站中的 BATCH 应用程序。

● 更新软件前，将 BATCH 启动协调程序设置为“手动”(Manual) 启动模式。

准备软件更新时，必须遵守上述几点内容。 更多相关信息，可参见“准备工作概述 
(页 34)”部分。 

有关更新 SIMATIC BATCH 的更多信息，请参见以下文档：   

● SIMATIC BATCH 自述文件；B 部分，安装

● 手册《过程控制系统 PCS 7；SIMATIC BATCH》(Process Control System PCS 7; 
SIMATIC BATCH)
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更新 SIMATIC BATCH 工作站
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更新 SIMATIC 路径控制工作站 13
13.1 更新 SIMATIC 路径控制

更新 SIMATIC Route Control

相关信息，请参见文档《过程控制系统 PCS 7；SIMATIC Route Control》(Process Control 
System PCS 7; SIMATIC Route Control)。

说明

需要使自动化系统处于 STOP 模式

SIMATIC Route Control V8.0 SP1 需要使用 PCS 7 V8.0 SP1 中的库函数。 要加载这些

库，自动化系统必须处于 STOP 模式。
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更新 SIMATIC 路径控制工作站

13.1 更新 SIMATIC 路径控制
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从中央归档服务器 (CAS) 移植归档数据 14
14.1 归档移植总览

步骤概述

步骤 操作 ES OS 服务

器

OS 
客户

端

AS

58 从 CAS 移植归档数据 (页 135) 仅适用于已将中央归档服务器 
(CAS) 替换为 Process 
Historian 的项目。

归档数据的报告系统

Information Server 是 Process Historian 的报告系统。 必须再次创建归档的报表模板和自

动日志。

14.2 如何将归档移植到 Process Historian 中

要求

● 中央归档服务器不低于 PCS 7 V7.0 (Storage Plus V1.2)

● 所有归档都已在 PCS 7 下换出。

● 在 PCS 7 项目中创建并组态了 Process Historian。

● 启动 OS 服务器前已启动 Process Historian。

● 可通过 Process Historian 访问中央归档服务器的数据库。

● OS 服务器处于过程模式下。 已建立与 Process Historian 的连接。

● 当前数据已归档到 Process Historian 上。
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OS 服务器上的归档

OS 服务器上最后的归档数据段不再由 OS 服务器换出到 CAS。 用户必须将这些归档数据

从 OS 服务器直接导入到 Process Historian。 

注意，必须考虑 OS 服务器的循环归档设置，及时执行此导入操作。

建议： 首先导入 OS 服务器上那些还没有换出到 CAS 的归档数据段。

步骤

1. 在 CAS 上，为 Process Historian 组态 CAS 归档的访问共享。

2. 在 Process Historian 上组态访问 CAS 归档的网络驱动器。

3. 启动移植工具。 遵照说明操作。 
更多相关信息，请参见文档《SIMATIC；Process Historian；Process Historian 管理》
(SIMATIC; Process Historian; Process Historian Administration)。

4. 选择服务器的 CAS 数据库。

5. 将数据分配给子项目。

6. 启动移植过程。

说明

期间，将在后台进行所有 CAS 数据库的移植。

必须对每个 OS 子项目执行数据移植。

更多信息

更多相关信息，请参见文档《SIMATIC；Process Historian；Process Historian 管理》

(SIMATIC; Process Historian; Process Historian Administration)。

从中央归档服务器 (CAS) 移植归档数据

14.2 如何将归档移植到 Process Historian 中
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附录 A
A.1 “Pcs7Cntx”块的块 I/O 总览

概述

下表列出了标准库中的块 I/O 与 APL V8.x 的块 I/O 之间的分配情况：

标准库 APL V8.x

块名称 I/O 类型 块名称 I/O 类型

CH_CNT LATCH I Psc7Cnt1 Connect 输入

 SET_DO1 I  SetDO1 输入

 LADDR I  Laddr 输入

 CHANNEL I  Channel 输入

 ENSET_UP I  EnSetUp 输入

 ENSET_DN I  EnSetDn 输入

 CTRL_DO0 I  CtrlDO0 输入

 CTRL_DO0 I  CtrlDO1 输入

 CTRL_DO2 I  CtrlDO2 输入

 CTRL_DO3 I  CtrlDO3 输入

 SET_DO0 I  SetDO0 输入

 SET_DO2 I  SetDO2 输入

 SW_GATE I  SwGate_En 输入

 SET_DO3 I  SetDO3 输入

 GATE_STP I  StopGate 输入

 USE_CNT I  Cnt_En 输入

 USE_MSRV I  MsrV_En 输入

 LAST_ON I/O  Feature Bit 30 输入

 LOAD_VAL I  LoadCnt / LoadCnt_IN 
(Struct)

输入

 CMP_V0 I  CmpV0 输入

 CMP_V1 I  CmpV1 输入
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标准库 APL V8.x

 CMP_V2 I  CmpV2 输入

 CMP_V3 I  CmpV3 输入

 LOAD_PRE I  LoadPre_IN 输入

 LOAD_DIR I  LoadDir_IN 输入

 RES_SYNC I/O  ResSync_IN 输入

 R_OP_ERR I/O  ResOpErr_IN 输入

 SIM_ON I  SimOn 输入

 SIM_CNT I  SimCnt 输入

 SIM_MSRV I  SimMsRv 输入

 SUBS_CNT I  SubsCnt 输入

 SUBS_MSRV I  SubsMsRv 输入

 SUBS_ON I  Feature Bit 29 输入

 FM_DATA I/O  FM_DATA 输入/输
出

 MODE I/O  Mode 输入/输
出

 QBAD O  Bad 输出

 QMOD_ERR O  ModErr 输出

 QOP_ERR O  OpErr 输出

 QSIM O  SimAct 输出

 QRUN O  CntRun 输出

 QDIR O  CntDir 输出

 RES_SYNC I/O  ResSync_OUT 输出

 QZERO O  ZeroSt 输出

 QOFLW O  OFlow 输出

 QUFLW O  UFlow 输出

 QSYNC O  CntSync 输出

 QGATE O  IntGate 输出

 QSW_G O  SwGate 输出

 QUALITY O  --  

 QSET O  Set_DI 输出

 QLAST O    

附录

A.1 “Pcs7Cntx”块的块 I/O 总览
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标准库 APL V8.x

 QLATCH O  NewLatch 输出

 QSTA O  StartDI 输出

 QSTP O  StopDI 输出

 QSUBS O    

 QCMP1 O  CmpVal0 输出

 QCMP2 O  CmpVal1 输出

 QCMP3 O  CmpVal2 输出

 QCMP4 O  CmpVal3 输出

 QCOMP1 O  StCmpV0 输出

 QCOMP2 O  StCmpV1 输出

 QCOMP3 O  StCmpV2 输出

 QCOMP4 O  StCmpV3 输出

 ACT_MSRV O  MsrV / MsrV_OUT 输出

 ACT_CNTV O  CntV / CntV_OUT 输出

标准库 APL V8.0

块名称 I/O 类型 块名称 I/O 类型

CH_CNT1 LADDR I Pcs7Cnt2 Laddr 输入

 LADDR1 I  Laddr1 输入

 LAST_ON I/O  Feature Bit 30 输入

 CHANNEL I  Channel 输入

 VALUE I  Connect 输入

 LOAD_VAL I  LoadCnt / LoadCnt_IN 
(Struct)

输入

 RES_DO I  ResDO_IN 输入

 RES_CNT I  ResCnt_IN 输入

 GATE_STP I  StopGate 输入

 SIM_ON I  SimOn 输入

 SIM_CNT I  SimCnt 输入

 SUBS_CNT I  SubsCnt 输入

 SUBS_ON I  Feature Bit 29 输入

附录
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标准库 APL V8.0

 MODE I/O  Mode 输入/输
出

 QBAD O  Bad 输出

 QMOD_ERR O  ModErr 输出

 QOP_ERR O  OpErr 输出

 QSIM O  SimAct 输出

 QZERO O  ZeroSt 输出

 QRES_DO O  ResDO_OUT 输出

 QRES_CNT O  ResCnt_OUT 输出

 QSUBS O    

 QGATE O  Gate 输出

 QLAST O    

 ACT_CNTV O  CntV / CntV_OUT 
(Struct)

输出

 QUALITY O  -- 输出

标准库 APL V8.0

块名称 I/O 类型 块名称 I/O 类型

CH_CNT2M/
CH_CNT2C

ACT_CNTV O Pcs7Cnt3 CntV 输出

 ACT_MSRV O  MsrV / MsrV_OUT 输出

 ACT_LATCH I    

 CMP_VAL1 I  CmpV1 输入

 CMP_VAL2 I  CmpV2 输入

 CTRL_DO1 I  CtrlDO1 输入

 CTRL_DO2 I  CtrlDO2 输入

 CTRL_SYN I  CtrlSync_En 输入

 EXTF_ACK I  AckTrip 输入

 L_DIRECT I  LoadDir 输入

 L_PREPAR I  LoadPre 输入

 LADDR I  Laddr 输入

附录

A.1 “Pcs7Cntx”块的块 I/O 总览
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标准库 APL V8.0

 LAST_ON I  Feature Bit 30 输入

 LATCH I  Connect 输入

 LOAD_VAL I  LoadCnt / LoadCnt_IN 
(Struct)

输入

 MODE I  Mode 输入

 MSRV I  MsrV / MsrV_OUT 
(Struct)

输入

 OFLW I  OFlow / OFlow_IN 输入

 QBAD O  Bad 输出

 QCMP1 O  CmpVal1 输出

 QCMP2 O  CmpVal2 输出

 QCNT_DN O  CntDown 输出

 QCNT_UP O  CntUp 输出

 QDI O  Set_DI 输出

 QDO1 O  DO1St 输出

 QDO2 O  DO2St 输出

 QERR_24V O  V24Err 输出

 QERR_DO1 O  DO1Err 输出

 QERR_LOAD O  LoadErr 输出

 QERR_PARA O  ParaErr 输出

 QGATE O  IntGate 输出

 QLAS O    

 QMOD_ERR O  ModErr 输出

 QOFLW O  OFlow_OUT 输出

 QSIM O  SimAct 输出

 QSUBS O    

 QSYNC O  CntSync 输出

 QUALITY O  --  

 QUFLW O  UFlow_OUT 输出

 QZERO O  ZeroSt 输出

 SET_DO1 I  SetDO1 输入

 SET_DO2 I  SetDO2 输入

附录

A.1 “Pcs7Cntx”块的块 I/O 总览
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标准库 APL V8.0

 SIM_CNTV I  SimCnt 输入

 SIM_MSRV I  SimMsRv 输入

 SIM_LATCH I    

 SIM_ON I  SimOn 输入

 SUBS_CNTV I  SubsCnt 输入

 SUBS_MSRV I  SubsMsRv 输入

 SUBS_LATCH I    

 SUBS_ON I  Feature Bit 29 输入

 SW_GATE I  SwGate_En 输入

 UFLW I  UFlow / UFlow_IN 输入

参见

如何创建块 I/O 的新互连 (页 122)

附录

A.1 “Pcs7Cntx”块的块 I/O 总览
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“WinCC 3D”设计, 94

E
ES 和 OS 上的安装和设置概述, 49

O
OS

编译, 110
编译概述, 108
编译模式, 108
过程模式下的用户界面, 94
激活概述, 127
检查 OS 服务器上的设置, 127
检查 OS 客户端设置, 128
使用项目移植器更新, 67
指定编译模式, 109
自定义 OS 客户端的设置, 112

OS Web 选件, 107
OS 编译模式, 108, 109

P
PC 站, 57

计算机名称, 23
下载, 57
组态, 57

PCS 7 Library V7.1 通道块, 61
Process Historian

修改归档, 135

S
SIMATIC BATCH, 17

移植, 17
StoragePlus

分离归档段, 31
修改概述, 31

安

安装
PCS 7, 50
SIMATIC PDM, 51
附加库, 61

备

备份, 34
许可证密钥和授权, 43

编

编程设备操作, 56
编辑操作员文本, 80
编译 CFC, 93
编译 OS, 108

操

操作员文本和显示文本
导出, 39

操作员文本或显示文本, 38

处

处于组态模式和编程设备 (PG) 模式的模块, 56

传

传送块类型的事件文本, 88

从

从其它库复制对象, 80

导

导出
操作员文本和显示文本, 39

导入
如何在块导入期间传送块类型的事件文本, 88

导入操作员文本, 89
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导入运行数据, 69

钝

钝化响应, 22

复

复制块, 82

概

概述, 67
NetPro 中的修改, 75
操作站上的修改, 94
更新块, 77
软件更新步骤, 25
项目中的常规修改, 67
转换 CFC/SFC, 75

更

更改多语言文本的组态, 69
更换硬件后进行组态, 71
更新

BATCH, 131
PCS 7, 17
PCS 7 项目, 67
SIMATIC BATCH, 17
SIMATIC Route Control, 17
画面对象, 97
应用使用 SIMATIC Logon 服务的 PCS 7 组
件, 108
装有项目移植器的 OS, 67

更新 PCS 7, 50
更新项目中的 SFC 块类型, 92
更新项目中的块类型, 90

工

工作原理, 107
PCS 7 OS Web 选件, 107

归

归档服务器
CAS, 31
分离归档段, 31
修改归档, 135

规

规划和准备, 45

过

过程模式下的用户界面, 94

混

混合操作, 115

激

激活操作站概述, 127

计

计算机名称, 23

检

检查 PH 一致性, 69

库

库, 22
PCS 7 Library V7.1 通道块, 61
安装附加库, 61, 62
备份用户创建的库, 37
从其它库复制对象, 80
将对象从其它库复制到主数据库, 81

块

块导入, 88
块更新概述, 77

密

密码保护, 67

面

面板和消息文本中的语言, 78
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命

命名约定
PC 站, 23
计算机, 23
计算机名称, 23

模

模板画面
更新画面对象, 97

冗

冗余, 22

软

软件更新步骤, 25
软件更新的准备工作, 34

通

通过自动化许可证管理器进行许可, 24

下

下载, 57
PC 站, 57

下载到目标系统, 125

项

项目移植器
密码保护, 67

修

修改
基本画面和计算机的本地响应, 94

修改操作模式, 59
修改传输率, 59

许

许可证密钥, 24
备份, 43

选

选择正确文档, 17

要

要求, 19

移

移植
SIMATIC BATCH, 17
SIMATIC Route Control, 17

移植诊断设置, 105

运

运行数据, 69

在

在 NetPro 中检查并修改连接数据, 75
在线趋势控件, 85

定义, 85

中

中央归档
修改, 31

主

主数据库, 81
复制块, 82
更新块, 86

转

转换 CFC/SFC 图表, 77

准

准备 PC 站, 49
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自

自定义操作员文本, 89
自动协商, 59

组

组态模式, 56
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